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XML transformation
Use the XML stage to create powerful hierarchical transformations, as well as parse
and compose XML data with high performance and scalability.
Many industries have standardized on Extensible Markup Language (XML) as the
mechanism to use to exchange information between organizations. With the
broader acceptance and use of these standards, companies have increasingly
looked to XML to also satisfy requirements for the exchange of information
between different IT units within their organization. The business projects for
which XML has been adopted have generated specific requirements for IT. In some
cases, the data volume that is represented in an XML document is minimal. For
example, the data might represent a single transaction, but it might have many
layers of hierarchical complexity. Other projects require that multi-gigabyte files
with relatively simple XML schemas be transformed into a new format that
prescribes to an industry standard. When the data volume and complex hierarchy
requirements meet, they often present their own challenges to traditional IT tools.
The XML stage includes capabilities that easily manage the design and processing
requirements presented by the most challenging XML sources. The IT developer
can leverage the schema library manager to register the XML metadata in its native
form. This metadata forms the basis which guide the design activities. The XML
stage uses an integrated user interface component called the assembly editor to
facilitate the transformation of XML data from hierarchical to relational or other
hierarchical formats, or from relational to hierarchical formats. After the logic is
constructed, the job runtime leverages unique components that provide various
forms of parallelism that are built specifically for hierarchical data formats, such
XML. With these mechanisms IBM® InfoSphere® DataStage® scales to meet very
high volumes and manage system resources efficiently.

Choosing an XML solution
InfoSphere DataStage provides two XML solutions: the XML pack and the XML
stage. The XML pack, which includes the XML Input, XML Output, and XML
Transformer stages, is useful if you have already made an investment in using this
technology or if you want to perform only very simple transformations that do not
involve a large amount of data. The XML stage the best choice if you have not yet
created an XML solution and want perform complex transformations on large
amounts of data.

Schema management
Use the Schema Library Manager to import schemas into the metadata repository
and to organize them into libraries that can be shared across all DataStage projects.
Before you can use the XML stage to produce or consume data, you must import
the XML schemas that describe the data into the metadata repository. To import the
schemas, you use the Schema Library Manager, which is available from the IBM
InfoSphere DataStage and QualityStage™ Designer via the menu choice Import >
Schema Library Manager.
After you import a schema, you can browse the type structure that the schema
defines. You use these types to define the processing in the XML stage. The
© Copyright IBM Corp. 2010, 2011
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schemas that you import are available for use with any data. To use a schema with
specific data, you bind the physical location of the data to the schema. For
example, to read an XML file, you provide a path to the XML file and select the
schema for the data that the file contains. When you work with XML data, you
perform the binding when you configure the XML Parser or XML Composer step
in an assembly.
You can add related schemas to the same library. Schemas that are in the same
library can refer to each other. For example, one XML schema can use an XML
include element or an import element to refer to another schema that is in the
same library. Schemas that are in one library cannot refer to external schemas or to
schemas that are in another library.
When you create a library, you specify a unique name for the library and an
optional category name. Library names must be unique across all categories.
Organizing libraries into categories ensures that you can later locate a specific
library.
After you add schemas to a library, the library is automatically validated to
determine if the schemas contain any errors. If the validation is successful, the
library contains all of the element and type definitions from the schemas. If the
library is invalid, you are notified that there are errors. To view the list of errors,
click Validate. Whenever you modify a schema, delete a schema from the library,
or add a new schema to the library the library is automatically re-validated.
Schemas are used only at design time, not at runtime. Therefore, modifying a
schema or deleting a schema from a library has no effect on existing jobs that use
the schema.
If you modify a schema that is already being used by a job, the schema
modifications are not automatically passed on to the job. If you want to apply a
modified schema to an XML stage, you must edit the XML stage to retrieve the
modified schema.
Within a library, you cannot repeat the same type definition; however, two
different libraries can have the same type definition. Having the same type
definition in two different libraries is useful if you want to have two versions of
the same type definition.

Opening the Schema Library Manager
You use the Schema Library Manager to import the schemas to use in jobs that
include the XML stage.

About this task
You can open the Schema Library Manager from IBM InfoSphere DataStage and
QualityStage Designer or from the Libraries tab, which is available from the
Assembly Editor.

Procedure
Do one of the following:
v From the InfoSphere DataStage and QualityStage Designer, choose Import >
Schema Library Manager.
v From the Assembly Editor, click the Libraries tab.
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Working with libraries and resources
Use the Schema Library Manager to import resources, such as XML schemas, and
to create and manage libraries of resources.
Use the istool command line to transfer contract libraries between metadata
repositories of IBM InfoSphere Information Server. Libraries are stored in the
metadata repository and are available for use in any job that uses the XML stage.
In the metadata repository, a contract library is represented by the library name,
followed by the extension .cl. When you work with multiple installations of
InfoSphere Information Server, you might want to transfer a contract library from
one installation to another installation, for example, from a test environment to a
production environment.
You can import and export contract libraries using the istool functionality. For
more information, see . For more information about exporting and importing
common metadata assets by using the command line, see http://
publib.boulder.ibm.com/infocenter/iisinfsv/v8r7/topic/
com.ibm.swg.im.iis.iisinfsv.assetint.doc/topics/pdrassets.html.
Table 1. Working with libraries
Task

Action

Creating libraries

1. Click New Library.
2. Enter a name.
3. Enter a description and the name of a
new or existing category.

Refreshing library lists

Click the Refresh icon at the top of the
Libraries pane.

Removing libraries

Select a library, and click Remove.

Opening libraries

Select a library, and click Open. You can
open a library only if it has been validated
and has no errors. The Types tab displays a
list of namespaces and the belonging types.
To view the schema for a type, select a type
from the Types tab. To view the facets and
attributes for a node, select the node from
the Schema tab.

Recategorizing libraries

To move a library to a different category,
edit the Category field in the library details.

Table 2. Working with resources
Task

Action

Importing resources

1. Select the name of a library, and click Import new
resource.
2. Select the file to import, and click Open. You can
select a single .xsd file or a .zip file that contains
multiple .xsd files.
3. After importing all of the required resources into the
library, the library is automatically validated. If the
library is valid, a green checkmark displays beside its
name. If it is not valid, a red exclamation point
displays beside its name.
4. If the library is invalid, click Validate to display the
list of errors.
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Table 2. Working with resources (continued)
Task

Action

Displaying the types in schemas

Double-click the name of a library to display the Types
and Schema tabs. On the Types tab, click the plus sign
beside a namespace to display a list of types that belong
to the namespace. Click a type to display the schema for
the type on the Schemas tab. Browsing the types and
their structures is useful for a variety of reasons. You can
determine which type corresponds to a specific
document instance by matching the top-level element
name with the type name. You can determine which
pieces of information are optional but could be included
in similar documents. You can view the characteristics of
the data, so that you can understand how to set
transformation options.

Exporting resources

Select the resource, and then click Export to save a copy
of the resource on the local computer.

Updating resources

If you modify a resource and want to update it in the
library, select the resource, and then click Replace
Selected Resource. The updated resource has no effect
on jobs that used the earlier version of the resource. To
use the updated version in an existing job, you must edit
the assembly.

Deleting resources

Click the Delete icon that displays beside the resource
name. Deleting a resource has no effect on existing jobs
that use the resource.

Displaying the resources in a library

Click the name of a library. For the XML stage, the
Resources view displays a file location and a namespace
for each schema in the library. Click the name of a
schema to display additional details about each schema.

Editing resource details

Only the File Location and Description fields can be
updated. After you update the file location, the library is
automatically validated.

Related information
http://publib.boulder.ibm.com/infocenter/iisinfsv/v8r7/topic/
com.ibm.swg.im.iis.iisinfsv.assetint.doc/topics/pdr_cli_export.html
http://publib.boulder.ibm.com/infocenter/iisinfsv/v8r7/topic/
com.ibm.swg.im.iis.iisinfsv.assetint.doc/topics/pdr_cli_import.html

Creating an example schema library
Create an example of a library and import the schemas.

About this task
The library can have more than one schema. The schemas can be interdependent. If
the schemas are interdependent and if you import only one schema, the library
displays an error. To ensure that the library is valid you must import the
dependent schema.

Procedure
Start the IBM InfoSphere DataStage and QualityStage Designer.
Choose Import > Schema Library Manager.
On the Libraries tab, click New Library.
In the New Contract Library window, enter Example_library for the name of
the library.
5. Click OK to save the library.
6. Select the library that you created, Example_library, and then click Import
New Resource from the Resource View.
1.
2.
3.
4.
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7. Select the schema, department.xsd.
8. The File Upload Complete window is displayed.
9. Click OK.
The library is not valid and the error message, “One or more resources failed
validation. Click Validate to view the errors” is displayed.
10. Click Validate to view the actual error. Following figure shows the error.
The error indicates that the schema department.xsd has a dependency on

another schema, definition.xsd. The schema department.xsd contains an
element named dept_id that has the type dept_id1. Because the type dept_id1
is defined in the schema definition.xsd, you need to import it, too.
11. Import definition.xsd and click Validate. The error still exists because the file
location for definition.xsd is incorrect.
12. Perform the following steps to specify the file location:
a. Open department.xsd. The department.xsd is shown below:
<?xml version="1.0" encoding="UTF-8"?>
<xs:schema xmlns="http://www.ibm.com/departments"
xmlns:xs="http://www.w3.org/2001/XMLSchema"
targetNamespace="http://www.ibm.com/departments">
<xs:include schemaLocation="http://ibm.com/definitions/definition.xsd"/>
<xs:element name="Info">
<xs:complexType>
<xs:sequence>
<xs:element name="dept_id" type="dept_id1"/>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:schema>

b. Copy the schema location, http://ibm.com/definitions/definition.xsd
from the include statement.
c. In the Resources View, select definition.xsd and paste the schema
location below in the File Location field as shown in the following figure.
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13. Click on any other field to refresh the view. The error gets resolved and the
library becomes valid. The following figure shows the resolved view.

14. Click OK to close the Libraries window.

Using the XML stage
Use the XML stage to parse, compose, and transform XML data.
The XML stage is available in the Real Time section of the palette in the IBM
InfoSphere DataStage and QualityStage Designer. You can use the XML stage in
server jobs and in parallel jobs. In parallel jobs, the XML stage can have multiple
input and output links. In server jobs, the XML stage can have only one input link,
but it can have multiple output links. You can use the XML stage as source stage,
which has only output links; a middle stage, which has both input and output
links; or a target stage, which has only input links.
The XML stage page displays a preview window that shows the XML stage and
any input or output links. The page displays a set of runtime properties that you
can configure, and the Edit assembly button. When you select the stage in the
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preview window and then click Edit assembly, the Assembly Editor opens. You
use the Assembly Editor to create the assembly for the XML stage. When you close
the Assembly Editor, the assembly is saved as part of the stage.
To create the columns on an input or output link, click the link in the preview
window to display the links view. Then click the Columns tab and create the
columns on the link.

Configuring runtime properties for the XML stage
To modify how the XML stage runs in the job, configure these properties.
Heap Size (MB)
Enter the maximum heap size, in MB, for the Java Virtual Machine. This
property corresponds to the -Xmx command line option. Specify at least
256 MB. Consider specifying a larger heap size if the assembly includes a
large schema and large documents.
Stack Size (KB)
Enter the size of the stack, in KB, for the Java Virtual Machine. This
property corresponds to the -Xss command line option.
Other Options
Enter additional command line arguments to the Java Virtual Machine. For
example, to set a system property, enter DSystemProperty=Value.
Use Scratch Disk
Yes (default) specifies that at runtime, data might be written to disk if
processing does not fit into main memory. If set to No, the job might fail at
runtime if processing does not fit into main memory. Performance is faster
if you do not use a scratch disk; however, you risk not having enough
memory for the job.
Threads
Enter the number of threads for the assembly. The default is 4. For possible
performance improvements, set the number of threads equal to the number
of CPUs. Decrease the number of threads if the CPU use for the job is too
high. Increase the number of threads if you need fast throughput or when
the assembly has many steps. There is no benefit to setting the number of
threads to be higher than the number of steps in the assembly. Each step is
run by only one thread at a time.
Limit Output Rows
Enter Yes for Limit output rows, and then enter a value for Maximum
output rows. Limiting output rows is useful when you are debugging a job
and do not want to wait for the results of the entire job.
Maximum Output Rows
Enter Yes for Limit output rows, and then enter a value for Maximum
output rows. Output rows are calculated cumulatively across all output
links. The XML stage stops processing after generating the maximum
number of output rows.
Enable logging
Enter Yes to enable logging and set the log level to Warning. By default,
logging is not enabled. Enabling logging affects performance.
Log level
Specify the level of detail to log. Choosing a high level of logging affects
performance.

XML transformation
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Assembly Date
The date that the assembly was last saved.

The assembly
To configure the XML stage, you create an assembly.
An assembly is a series of steps that perform enrichments and transformations on
hierarchical data. By default, a new assembly always contains an assembly
Overview, an Input step, and an Output step. Between the Input step and the
Output step, you insert additional steps that parse, compose, or transform the data
from the previous step.
The assembly Overview provides creation and modification information about the
assembly and includes an optional field for the assembly description. This field
documents the purpose of the assembly and is helpful when you or others later
need to modify it.
The Input step transforms the relational structure – the links and columns – into a
hierarchical structure. In the hierarchical data structure, an input link is
transformed into a list item, and each column on the link is transformed into a
child content item of that list. The step Output schema displays the schema tree
that represents this hierarchical data structure. This data structure is passed to the
next step in the assembly, where it becomes the step Input. At each step, the step
Input is modified by the action of the step. For example, if you use an Aggregate
step to perform a calculation, the result of the calculation is added as a branch to
the step Output. Additions to the step Output are highlighted in the schema tree.
The Output step receives the results of all of the previous step transformations. In
the Output step, you map the hierarchical data structure back to a relational data
structure. That is, you map schema items to output links and to the columns on
those links.

Overview
The Overview of an assembly provides creation and modification information
about the assembly and includes an optional description field that you can modify.
On the Overview, you can enter an optional description for the assembly. This field
documents the purpose of the assembly and is helpful when you or others later
need to modify the assembly.

Input step
The Input step describes how the links and columns of a relational data structure
are represented as a hierarchical data structure.
The Configuration tab of the Input step provides two views: a Links view and a
Tree view.
The Links view displays the same column definition table that you see in on the
Columns tab of a stage. From the Links view, you can edit the column definitions
and then view the result in the step Output. When you save the assembly, the
edited column definitions are saved in the job properties.
The Tree view displays the relational links structure after it has been transformed
into a hierarchical structure. The root element is Top, and it contains the entire
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input data. Each input link is transformed into a child list item of the InputLinks
node. Each column is transformed into a content item and assigned a primitive
type. For example, a column that is assigned the SQL Varchar type is transformed
into an a content item that has the String data type.
When waves are used in a job that uses the XML stage, each wave is a new item in
the Top list, and each item contains all of the data that belongs to a particular
wave. When waves are not used, the Top list always contains a single item that
contains all of the data that passed through the stage.
The step Output of the Input step becomes the step Input for the next step in the
assembly. This process of taking the transformed data structure from the previous
step; transforming, parsing, or composing data; and then producing a modified
data structure for the next step continues through each step in the assembly. At
each step, you can look at the step Input, which displays the result of the previous
step, and the step Output, which displays the output results of the current step, to
assess the changes that each step makes to the data structure.
Note that not all assemblies use an Input step. For example, if the XML stage is
used as a source stage in a job, there are no input links and the Input step is
empty. Even if the Input step is empty, it remains a permanent part of an
assembly; you cannot remove it. Parallel jobs can receive input from multiple input
links, while server jobs can only receive input from a single input link.

Output step
The Output step describes how the hierarchical data structure is mapped to a
relational data structure.
The Configuration tab of the Output step provides two windows: Output and
Mappings.
In the Output window, you can display two views: a Links view and a Tree view.
The Links view displays the same column definition table that you see on the
Columns tab of a stage. From the Links view, you can edit the column definitions
and then view the result in the step Output. When you save the assembly, the
edited column definitions are saved in the job properties.
The Tree view displays the relational links structure after it has been transformed
into a hierarchical structure. The root element is Top, and it contains the entire
output data. Each output link is transformed into a child list item of the
OutputLinks node. Each column is transformed into a content item and assigned a
primitive type. For example, a column that is assigned the SQL Varchar type is
transformed into an a content item that has the String data type.
In the Mappings window, you map the hierarchical data structure to a relational
data structure.
You must map a source item to every item that is in the target structure and that
you want to include in the output. Start at the top of the target structure and map
items from the top down. Start by mapping target list nodes to source lists nodes.
As soon as you map a target list node, the target content nodes of that list are
available for mapping. Map the target content nodes of each mapped list node to
source content nodes.

XML transformation
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For more information about mapping, see Mapping data.
Not all assemblies use an Output step. For example, if the XML stage is used as a
target stage in a job and doesn't have any output links, the Output step is empty.
Even if the Output step is empty, it is a permanent part of an assembly; you
cannot remove it.

Assembly Editor
Use the Assembly Editor to create an assembly.
Each XML stage that you add to a job requires an assembly. An assembly defines a
series of steps that parse, compose, and transform hierarchical data.
The Assembly Editor has three panes: the Assembly Outline, the Step pane, and
the step Input/step Output pane. The Assembly Outline lists the names of the
assembly steps in the order in which they are performed.
To add a step to the assembly, you click the Palette button. Then you drag a step
from the palette to the location in the assembly where you want that step to be
performed or double-click a step to add it below the currently selected step in the
assembly. Steps are available for a variety of transformations, including sorting,
aggregating, joining, and pivoting.
When you click the name of a step in the Assembly Outline, the step displays in
the Step pane. Each step has three tabs: Configuration, Information, and Test
Data. The Configuration tab always contains mandatory fields that you must
complete to configure the step. The step Information tab is similar to the assembly
Overview; it displays creation and modification information, as well as optional
fields that you can use to document the name and purpose of the step. You use the
Test Data tab when you test the assembly. Testing is optional but extremely useful.
By testing, you can see the incremental change that each step makes. You can
evaluate how the step transformations affect the data and confirm that the
assembly is performing exactly the transformation that you want.
As you configure each step in the assembly, the Assembly Editor monitors your
work and maintains a running total of the issues that you need to address. An
issue is not necessarily an error. In many cases, an issue describes a specific field
that requires input or a item that requires mapping. To see all of the issues in the
assembly, click View All. The issues display, sorted by step. For each step, a handy
link is available, so that you can quickly jump to the step and start addressing the
issues. The issues are also displayed on the Configuration tab of the step that has
issues.
The step Input/step Output pane displays the step input and the step output as
schema trees. The step Input is the result of the enrichments and transformations
that were made by all of the previous steps in the assembly. The step Output
describes the output of the current step. For example, if the step adds a new node
to the data structure, the step Output highlights the new node. Within the
assembly, the output of one step is always the input for the next step in the
outline.
On the Output step, you can right-click on an item to display a menu of actions
that you can perform on that step. You can rename items so that they have more
meaningful names, delete unnecessary sub-trees, and perform other modifications.
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Opening the Assembly Editor
After you add the XML stage to a job, use the Assembly Editor to create the
assembly.

Procedure
1. From the Real Time section of the palette in the IBM InfoSphere DataStage and
QualityStage Designer, drag to add an XML stage to a job.
2. Double-click the XML stage to open the stage editor.
3. Click Edit assembly to display the Assembly Editor.
Note: The Edit assembly button provides the only way to open the Assembly
Editor; there is no menu choice for the Assembly Editor.

What to do next
After you finish working on the assembly, close the Assembly Editor to return to
the XML stage editor and to the job. If you plan to work for an extended period of
time on an assembly, be sure to close the Assembly Editor occasionally, so that
your changes are saved.

Modifying items in the step Output
Rename or drop an item, change a list item into a group item, or change a group
item into a list item.

About this task
Each step in an assembly transforms or enriches the schema and then presents the
result of all of the changes in the step Output. You can make minor modifications
to items in the step Output. These modifications are passed to the next step in the
assembly as part of the step Input.

Procedure
Select an item in the step Output, and then right-click to display a menu of choices
that are appropriate for the selected item.
Table 3. Item modifications
Choice

Action

Revert

Removes all modifications from the selected item.

Rename

Changes the name of the item. The previous item name displays when
you hover over the new item name.

Drop

Removes an item and all of its children.

Group-to-List

Changes a group item to a list item. Creates a list item that has the
selected list item as the only element. This option is available only for an
item that has children but that is not a list item. This option is useful
when a list transformation such as a join or a union should be conducted
on an optional group. When the group exists, it will have a list size of 1.
When the group does not exist, it will be an empty list.

List-to-Group

Changes the list item to a group item by taking only the first element of
the list. This option is available only for a list item. This action is useful
when a list item contains only one child item, and you want to remove
the complexity of dealing with the list. If the list contains more than one
instance, however, only the first instance is selected and the rest of the
instances are ignored.
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Testing assemblies
As you work on an assembly, you can use randomly generated data or XML source
data to test each step and view the output data.

About this task
Testing the assembly allows you to run the assembly in design mode without
compiling and running the job. Unlike a job, which you can test only when it is
complete and has no errors, you can test an assembly at any time during the
design process. Even if the assembly is incomplete and has errors, you can test the
steps in the assembly that do not have errors.
To test an assembly, you provide source data or use randomly generated data.
Then after you run the test, you can view the output from each step and see the
log messages that the stage would produce if it were run as part of the job.
You can test an assembly as soon as you add a step that is after the Input step and
that does not contain errors. Testing an assembly processes the data in the Input
step and in all of the subsequent steps. The test stops if it reaches a step that
contains errors. Incrementally test an assembly to determine if the steps in the
assembly are performing the transformations that you expect. If a step is not
performing as you expect, you can modify that step and then retest the assembly.
When you are sure that the assembly is working just as you want it to, you are
ready to run the job.
To test the assembly, you must provide test input data to the XML Parser step. If
the XML Parser step obtains its data from an upstream stage, you do not need to
provide test data. For any other case, you must either generate random test data or
provide actual source data to use in the test. If you do not provide input data, the
test automatically uses randomly generated data.

Procedure
1. To provide input test data for the Input step, click the Test Data tab and then
do one of the following:
v In the Input Links field, select the link that provides the real source data to
use.
v Click Generate Random Data to produce sample data to use in the test.
2. To provide input test data for the XML Parser step, click the Test Data tab and
then do one of the following:
v In the Disk Input Test Data window, select the link that provides the real
source data to use.
v Click Generate Random Data to produce sample data to use in the test.
3. Above the Test Data tab, click Test Assembly and then perform the following
steps:
a. If you created job parameters for the job, enter the values for the parameters
in the Test Values column of the Job Parameter Values table.
b. Click Run Test.
The Test Execution Log displays messages that describe the test.
4. Open each step that was included in the test. The Downstream Output Test
Data shows the data that the step produces for the next step. The Disk Output
Test Data shows the data that will be sent to an external resource.
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Parsing large schemas
To parse a schema that has over 2,000 nodes, you use configure multiple XML
Parser steps.
When you configure an XML Parser step and select a schema that has over 2,000
nodes, the first 2,000 nodes are available to be parsed. However, the remaining
nodes are automatically put into a chunk. To parse the chunk, you add a second
XML Parser step to the assembly and select String set for the XML Source. Then
select the chunk as the String set source item. On the Document Root tab, select
the global element that corresponds to the chunked sub-tree. If the global element
does not exist, modify the schema by creating global elements from in-line
elements.

Icons in the schema tree
The following table shows the icons the represent the types of items in the schema
tree.
Table 4. Icons that represent types in the schema tree
Icon

Name

Description

All

A complex type. The child
elements can appear 0 or 1
time, in any order, in the
data.

Any simple type

A simple type. The type can
contain the data for any
concrete simple type.

Base-64 binary

A binary type. The type
contains base-64-encoded
data.

Boolean

A logical type. The legal
values are true or 1 and false
or 0.

Byte

Numeric data that is in the
range from -128 to 127.

Byte string

Unparsed binary data.

Choice

A complex type. Only one
child can appear in the data.
If any child is optional, the
type can be empty.

Date

A date type that is in the
format CCYY-M-DD. A
trailing time zone is optional.

Date time

A datetime type that is in the
format CCYY-MMDDThh:mm;ss.sss. A trailing
time zone is optional.

Decimal

An arbitrary precision
decimal number.

Double

Double-precision 64-bit
floating-point number.

XML transformation
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Table 4. Icons that represent types in the schema tree (continued)
Icon
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Name

Description

Duration

A time period that is in the
format PnYnMnDTnHnMnS,
where n is one or more
digits.

Empty

A simple type that does not
contain any content.

Float

A single-precision 32-bit
floating-point number.

Hex binary

A simple binary type that
contains
hexadecimal-encoded data.

ID

A unique identifier.

ID reference

A reference to a unique
identifier.

Integer

Numeric data that is in the
range from -2147483648 to
2147483647

List

An array of a simple type.

List all

An array of the complex type
all.

List choice

An array of the complex type
choice.

List sequence

An array of the complex type
sequence.

Locale

The locale.

Long integer

Numeric data that is in the
range from
-9223372036854775808 to
9223372036854775807.

Name

A valid XML name. The
name starts with a letter,
underscore, or colon; and it
can contain letters,
underscores, colons,
hyphens, and periods.

Namespaces

Absolute or relative URI
references.

NCname

A non-colonized name. The
name starts with a letter or
an underscore; and it can
contain letters, underscores,
hyphens, and periods.

NMtoken

A single token that does not
contain any whitespace.

NMtokens

Multiple tokens that are
separated by whitespace.

Table 4. Icons that represent types in the schema tree (continued)
Icon

Name

Description

Qname

A simple type for a qualified
name. Qualification is
optional.

Recursive XML

Recursive, unparsed XML
data.

Sequence

A complex type. The child
elements must appear in the
specified order in the data.

Short integer

Numeric data that is in the
range from -32768 to 32767.

String

A string that has unmodified
whitespace.

Time

A time type that is in the
format hh:mm;ss.sss. A
trailing timezone is optional.

Token

A string in which all
whitespace is replaced by a
space and multiple spaces
are replaced by a single
space.

Type schema

A graphical view of the
schema.

Unknown

A new or unknown type.

URI

An absolute or relative URI
reference.

Unparsed XML

Unparsed XML data.

The following table shows the icons that indicate the state of specific items in the
schema tree.
Table 5. Icons that indicate the state of items in the schema tree
Icon

Description
Indicates the selected item.
Indicates that the item was renamed.
Indicates that the item was removed.
Indicates that multiple actions were
performed on the item – for example,
renaming it and changing it from a group to
a list.
Indicates that the item was changed from a
group to a list or from a list to a group.
Indicates the enrichment root item – that is,
the addition to the schema that occurs as a
result of the current step.
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Table 5. Icons that indicate the state of items in the schema tree (continued)
Icon

Description
Indicates that the enrichment root item was
renamed.
Indicates that the enrichment root item was
removed.
Indicates that multiple actions were
performed on the enrichment root item.
Indicates that the enrichment root item was
changed from a group to a list or from a list
to a group.

Details Inspector
The Details Inspector displays information about the attributes and facets of a
selected item and about the definition of DataStage columns.
Table 6. Attributes in the Details Inspector
Name

Description

Name

The name of the item that was selected for
inspection.

Type

The XML type of the item.

Type Name

The base type of the item.

Optional

Indicates if the item is optional. For
example, in XML, an item is optional when
it has minOccurs="0" or when it has the
attribute xs:use="optional".

List

Indicates if the item is an array.

Recursive

Indicates if the item is recursive.

TypeName Namespace URI

The namespace URI of the type.

Item Namespace URI

The namespace URI of the item.

Type Documentation Annotation

An annotation that is defined in the XML
schema for the type or an explanation of a
created type.

Item Documentation Annotation

An annotation that is defined in the XML
schema for the item.

Nillable

Indicates if the item can have nil as its
value.

Max Occurs

The maximum times that the item can occur.

Min Occurs

The minimum times that the item can occur.

Table 7. Facets in the Details Inspector
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Name

Description

Whitespace

Indicates how whitespace is handled:
preserve all whitespace, replace each
whitespace with a space, or replace all
whitespace with a single space.

Fraction Digits

The maximum number of fractional digits.

Total Digits

The maximum number of significant digits.
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Table 7. Facets in the Details Inspector (continued)
Name

Description

Max Length

The length of the value must be less than or
equal to maxLength.

Min Length

The length of the value must be greater than
or equal to minLength.

Max Exclusive

The value must be less than maxExclusive.

Min Exclusive

The value must be greater than
minExclusive.

Max Inclusive

The value must be less than or equal to
maxInclusive.

Min Inclusive

The value must be greater than or equal to
minInclusive.

Enumeration Value

The value must match one of the
enumerated values.

Length

The length of the item.

Pattern

The pattern that is defined for the item.

When you select an item in the Output schema of the Input step or when you
select an item in the Input schema of the Output step, the Details Inspector
displays information about the selected DataStage column.
Table 8. DataStage column definition information in the Details Inspector
Name

Description

Type

Indicates if the item selected represents a
link or a column.

SQL Type

The SQL type that is defined for the column.

Key Position

Indicates if the column is defined as a key.

Extended

The extended type of the column.

Precision

The precision value defined in the column.

Scale

The scale value defined in the column.

Nullable

Indicates if the column value can be null.

Level Number

The level number defined in the column.

Display Size

The display size defined in the column.

Data Element

The data item defined in the column.

Description

The description defined in the column.

Mapping data
Understanding how to map source data to target data is key to obtaining the
results that you want when you transform hierarchical data.

Working with the mapping table
Some steps, such as the Output step and the XML Composer step, require that you
create mappings that define how to create the target nodes.
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For these steps, the Mappings tab displays the mapping table. This table contains
three columns: Source, Result, and Target. The Target column displays the elements
in the target structure. The Source column contains the mapping for each mapped
element in the target structure. The Result column displays the status of the
current mapping. The table contains one row for every level in the target data
structure. While every level is shown, you only map target list nodes to source list
nodes and target content nodes to source content nodes. The mapping table does
not allow you to map a list node to a content node or to map a content node to a
list node.
Content items have a primitive value and correspond to actual values. List items
repeat in the data. Elements that have maxOccurs>1, xs:list items, and links are all
represented by list items.
You must map a source item to every required item in the target structure. Start at
the top of the target structure and map items from the top down. Start by mapping
target list nodes to source lists nodes. As soon as you map a target list node, the
target content nodes of that list are available for mapping. Map the target content
nodes of each mapped list node to source content nodes.
A list mapping defines how instances in the target list are created. For each item in
the source list, a target item is created, and the content mapping is computed in
the context of that source item. The context is defined as all of the parent items
that contain the item.
For each target node, the mapping table provides a list of valid mapping
candidates. The valid candidates are evaluated based on the target position in the
target tree, its parent mappings, and its data type. The valid candidates are than
scored and ordered based on name similarity to the target node and path.
There are four ways to map an item. First, you select the row in the mapping table,
and then perform one of the following steps:
1. Click the down-arrow in the Source column to display a partial list of valid
mapping candidates. Then select an item from that list.
2. Click Auto Map to automatically map the source item that received the highest
mapping score. Automatic mapping is context-sensitive. If you select a list item
and then click Auto Map, the list item and all of its descendent items are
automatically mapped.
3. Click the down-arrow in the source column, and then click More to display the
entire source structure as tree. In the tree, you can select any node, even if it is
not a valid mapping candidate. If you select an invalid node, a message
displays to describe why the mapping is invalid.
To see the source structure as a list, click Switch to List View. Then select an
item to map. The list view displays a Target Similarity button. To control how
many mapping candidates display, select a target score. Only the candidates
that have a score higher than the one that you select display in the list.
4. To assign a fixed value to the target content item, click the down-arrow in the
source column, click Constant, and then enter a fixed value to map to the
target item. Note that the Constant option is not available for list items.
As you perform the mappings on the Output step, you might determine that the
target contains one or more items that you do not need. To remove an item from
the target structure, select the item, and then click the delete icon in the rightmost
column of the table. This action is similar to removing columns from the output
link.
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If you decide to change a mapping, select the item and then choose a different
mapping candidate.
If you use any method other than automatic mapping to map an item, a Lock icon
displays in the first column of the table to indicate that the mapping is locked.
If you decide that you want to remove one or more mappings, select an item and
click Clear Mappings.

Determining mapping candidates
For each item in the target structure, the mapping table automatically presents a
list of valid mapping candidates.
To determine the candidates to display in the mapping candidate list and to
determine which candidate to use for the Auto Map option, the mapping
algorithm uses the following process:
1. Create a list that contains all of the valid mapping candidates. Valid candidates
are unambiguous.
2. Select only the candidates that meet the specified level of conversion accuracy.
By default, the level for conversion accuracy is lossy; candidates must have a
data type that can be converted to the target data type without creating a
possible runtime error.
3. Evaluate the similarity of the name and of the data type of the source and
target items. Assign a score to each candidate, based on the similarity of the
names and data types.
4. Select the highest scoring candidate to use for the Auto map option.
5. Select the highest scoring candidates to present on the mapping candidate list,
which displays when you press the down-arrow on the source item in the
mapping table. By default, the mapping candidate list displays the top 5
candidates.
To change the level of conversion accuracy and the number of mapping candidates
to present on the candidate list, choose Administration > Mapping Configuration.

Mapping example
To understand why certain mapping candidates are valid or invalid, review this
example. The following figure shows the step Input. The step Input contains the
following items that are peers of each other:
v An item named documentID.
v A list named mySourceList, which contains an item named sourceChildField and
a list item named sourceChildList, which contains an item named
sourceDescendentField.
v A list named Peer-List, which contains an item named peerField.
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The following figure shows the instance data that the step receives and transforms
to the target structure:

The following is the XML data that this example uses. As you read about valid and
invalid mapping candidates, refer to this data so that you can understand how the
data values are determined:
<SourceDoc>>
<documentID>ID001</documentID>
<mySourceList>
<sourceChildField>A1</sourceChildField>
</sourceChildList>
<sourceDescendentField>A11</sourceDescendentField>
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</sourceChildList>
<sourceChildList>
<sourceDescendentField>A12</sourceDescendentField>
</mySourceList>
<mySourceList>
<sourceChildField>A2</sourceChildField>
</sourceChildList>
<sourceDescendentField>A21</sourceDescendentField>
</sourceChildList>
<sourceChildList>
<sourceDescendentField>A22</sourceDescendentField>
</mySourceList>
<Peer-List>
<peerField>peer1</peerField>
</Peer-List>
<Peer-List>
<peerField>peer2</peerField>
</Peer-List>
</SourceDoc>

The following figure of the mapping table shows that list item mySourceList is
mapped to list item myTargetList, and all of the child items of myTargetList are
correctly mapped.

Valid mappings
List mapping determines how the items of a target list are created. During item
creation, the source list is iterated; and for each item in the source list, a new item
is created in the target list. A child list is similarly iterated in a nested loop.
Content mappings are evaluated in the context of the iteration. In other words, the
target value of an item depends on the source list item that is currently being
iterated and on the mapping .
The following mappings are valid for the example:
List mapping
For each item in mySourceList, one item in myTargetList is created.
Therefore, two myTargetList items are created for the two mySourceList
items that are in the input data.
Simple content mapping
To create the first myTargetList item, the mapping top/result/SourceDoc/
mySourceList/sourceChildField evaluates to A1. Therefore, the value of
targetField is A1. To create the second myTargetList item, the mapping
top/result/SourceDoc/mySourceList/sourceChildField evaluates to A2.
Therefore, the value of targetField is A2.
Ancestor content mapping
To create the first myTargetList item, the mapping top/result/SourceDoc/
documentID evaluates to ID001. When looking for the value of
documentID, the containment relationship is taken into account. Because
mySourceList is contained within a single document that has only a single
XML transformation
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documentID value, the mapping is unambiguous; and the value of
targetDocumentID is ID001. The second myTargetList item has the same
containment relationship. Therefore, the mapping top/result/SourceDoc/
documentID valuates to ID001. Consequently, both target items have the
same documentID value.
Child list mapping
Valid mappings always preserve containment relationships. Therefore,
targetChildList must be mapped to a descendent list of mySourceList. Each
child list has two items because the sourceChildList has two items in the
input data.
To modify or create a containment relationship, add a transformation step,
such as an HJoin step or a Union step, before the step that contains the
mapping table.

Invalid mappings
The mapping table prevents you from creating ambiguous, invalid mappings. An
ambiguous mapping occurs when you map an item that, when evaluated, returns
multiple values. The following mappings are invalid:
Mapping the content child of a peer list to a child content item
When iterating on the first mySourceList and trying to evaluate the
mapping top/result/SourceDoc/Peer-List/peerField, the two values peer1
and peer2 are returned. The containment relationship for the mySourceList
item does not help to resolve which value should be returned. Therefore,
the mapping is ambiguous and is not allowed.

Mapping content child of a descendent list to a child content item
When iterating on the first mySourceList and trying to evaluate the
mapping top/result/SourceDoc/sourceChildList/sourceDescendentField,
the two values A11 and A12 are returned. The containment relationship for
the mySourceList item does not help to solve which value to return
because both values are contained in the mySourceList. Therefore, this
mapping is ambiguous and it not allowed.
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Mapping peer list to a child list
List mapping can be ambiguous. When iterating on the first mySourceList
and trying to evaluate the mapping top/result/SourceDoc/Peer-List, the
mapping cannot determine whether to return the first or the second
Peer-List item. Without a containment relationship between the items of
Peer-List and mySourceList, the ambiguity cannot be resolved. Therefore,
this mapping is invalid.

The following figures show the valid choices:
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Configuring how mapping candidates are determined
Configure how mapping candidates are calculated and displayed.

Procedure
1. Click Administration and then select Mapping Configuration.
2. Perform one or more of the following steps:
v In the Strings to Use as Keys field, enter one or more strings to use to
recognize good key items. Items with names that contain one of the common
key identifiers are scored higher than other items and presented as choices in
key fields.
v In the Data Type Conversion Accuracy field, select the default conversion
accuracy to use to select the mapping candidates that display in the Source
column of the Mappings table. The choices are:
Same type
Only source items that have the same type of the target item are
presented as mapping candidates.
Lossless
Only source items that have a type that can be converted without
loss of data to the target item type are presented as mapping
candidates.
Lossy (Default) Only source items that have a type that can be converted to
the target item type without causing a possible runtime error are
presented as mapping candidates.
v Select Map optional lists to automatically map lists that are optional.
v Select Map optional primitive data types to automatically map primitive
data types that are optional.
v In the Number of mapping candidates to display field, select the number
results to display as mapping candidates.

XML Parser step
Use the XML Parser step to parse one or more documents that have the same
structure.

XML Source
For the source of the XML data, specify one of the following:
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String set
Select the input schema item that contains the document string. Only items
that have the String, normalizedString, byteString, or XML data types are
available for selection.
Single file
Enter the path and file name, or click Insert Parameter and then select the
name of the parameter. The parameters that are available are those that
you previously defined in the job and the built-in macros that are in IBM
InfoSphere DataStage. Only items that have the String, normalizedString,
or byteString data types are available for selection.
File set
A file set option is used to read multiple xml files that are based on the
same xsd. Select the input schema item that will contain in runtime the
absolute paths (example, c:\test.xml) of the xml files. Only items that have
the String, normalizedString, or byteString data types are available for
selection.
Parallel Parsing
Open the section, and then click Compute to analyze the job and the input
XML document and then display the XML path to the body of the
document that will be parsed. For complete information about configuring
parallel parsing, see Configuring Parallel Parsing.
Enable Filtering
Enable filtering to apply an XSLT style sheet to the document before
parsing it. The document root must reflect the document that is created
from the result of the XSLT transformation. This option is not
recommended for large documents because the entire processing is done in
memory. For large documents, use transformation steps. This feature
cannot be used with the parallel parsing feature.

Document Root
Select the top-level element that describes the documents that you are parsing. The
types that display under the library's namespace are top-level element definitions.
Following the XML Schema standard, only top-level elements can describe
documents. The name of the element that you select must match the top-level
element name in the instance documents. For example, if you are parsing Order
documents, you select the Order element. When you select the element, you can
view its structure and verify that the structure is correct for the documents that
you want to parse.
Note: The elements from which you select the document root are from the
resources that were previously imported into the schema libraries. If you need to
import the resource that contains the document root for the XML Parser step, click
the Libraries tab and import the resource that you need. Then return to the
Assembly Editor and configure the document root.

Validation
By default, when the XML Parser step runs, it uses minimal validation, which
disables all of the validation rules and provides better performance than strict
validation does. Strict validation is initially configured so that each validation rule
is set to Fatal, and the job stops as soon as it parses the first occurrence of invalid
data. To customize validation, specify the action to perform when a violation
occurs.
XML transformation
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For more information about validation rules, see “XML Parser validation rules.”
For an example that includes the XML Parser step, see Example 1.

XML Parser validation rules
By default, the XML Parser uses minimal validation and ignores violations. To
customize validation, specify the action to perform when a violation occurs.
The following tables describe the validation rules and the applicable actions.
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Table 9. Value validation rules
Rule

Description

Data type has illegal
value

The value must match
the value rules for the
data type of the
corresponding item.

Actions
Ignore Type-checking and
type-conversion are not
performed. The types of the
items as they are defined by
the schema are replaced by
the String type. For
example, if the schema
includes an item named
startDate that is of type
Date, the type of that item
in the Step Output becomes
String, not Date.
Log per Occurrence; Log per
Document
Type-checking is performed.
If a type fails the check, a
log error is reported either
once for each occurrence or
once for the entire
document; however, parsing
continues. Type-conversion
is not performed. The real
types of the items in the
Step Output are replaced by
string types.
Reject

Type-checking and
type-conversion are
performed. Only invalid
values fail the invalid
document parsing. The
ParsingStatus item is added
as a new group to the Step
Output for the XML Parser
step and is set to False and
contains the corresponding
error message.

Fatal

Type-checking and
type-conversion are
performed. An invalid
value causes the job to fail.

Convert to Default
Type-checking and
type-conversion are
performed. An invalid
value is replaced with its
default value.
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Table 9. Value validation rules (continued)
Rule

Description

Actions

The value is checked
Value fails facet
Ignore Facet-checking is not
constraint
against the facets of its
performed.
Note: If you enable this corresponding item type.
rule, the Datatype has
Log per Occurrence; Log per
illegal value rule is also
Document
set with the same value
Facet-checking is
that is chosen for Value
performed. Log errors are
fails facet constraint rule.
issued for the violations,
and parsing continues.
Reject

Facet-checking is
performed. Invalid values
will fail only the invalid
document parsing, and the
ParsingStatus item, which is
added as a new group to
the step Output for the
XML Parser step, is set to
False with the
corresponding error
message.

Fatal

Facet-checking is
performed. An invalid
value causes the job to fail.

Convert to Default
Facet-checking is
performed. An invalid
value is replaced with its
default value.
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Table 9. Value validation rules (continued)
Rule

Description

Item than cannot be null
has a null value

Non-nullable items are
checked to ensure that
they do not contain null
values.

Actions
Ignore Null-checking is not
performed. All items in the
step Output for the XML
Parser step become
nullable. All items in the
step output become
nullable.
Log per Occurrence; Log per
Document
Null-checking is performed,
and log errors are issued.
Null values are set. As a
result, all items in the step
Output for the XML Parser
step become nullable.
Reject

Null-checking is performed.
Invalid values will fail only
the invalid document
parsing, and the
ParsingStatus item, which is
added as a new group to
the step Output for the
XML Parser step, is set to
False and includes the
corresponding error
message.

Fatal

Null-checking is performed.
An invalid value causes the
job to fail.

Convert to Default
Null-checking is performed.
An invalid value is replaced
with its default value.
Use global default values
for missing values

Trim values

Missing values are
replaced with their
default values.

Trim the white space
before and after a value
before performing
type-checking and
type-conversion.

False

If the schema defines a
default value for the item,
that default value is used.
Otherwise, the value is set
to nil.

True

If the schema defines a
default value for the item,
that default value is used.
Otherwise, the value is set
to the default value that is
specified in the Assembly
Administration panel.

False

Trimming is not performed.

True

Trimming is performed on
both sides of the value.
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Table 10. Structure validation rules
Rule

Description

Actions

Document is malformed

The document is
malformed.

Ignore No error message is logged.
Log per Document
An error message is logged.

Items are not declared in
the schema

Unexpected tags

Items in the instance
document must be
declared in the schema.
Violations might occur
when a job uses an
out-of-date version of a
schema.

The document contains
one or more unexpected
tags.

Reject

The ParsingStatus item,
which is added as a new
group to the step Output
for the XML Parser step, is
set to False and includes the
corresponding error
message.

Fatal

A malformed document
causes the job to fail.

Ignore No error message is logged.
Items are parsed based on
best guess.
Log per Occurrence; Log per
Document
Error messages are logged.
Items are parsed based on
best guess.
Reject

The ParsingStatus item,
which is added as a new
group to the step Output
for the XML Parser step, is
set to False and includes the
corresponding error
message.

Fatal

An item that is not declared
in the schema causes the job
to fail.

Ignore No error message is logged.
Items are parsed based on
best guess.
Log per Occurrence; Log per
Document
Error messages are logged.
Items are parsed based on
best guess.
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Reject

The ParsingStatus item,
which is added as a new
group to the step Output
for the XML Parser step, is
set to False and includes the
corresponding error
message.

Fatal

An unexpected tag causes
the job to fail.

Table 10. Structure validation rules (continued)
Rule

Description

Mandatory items are
missing

Items must appear
Ignore Checking for mandatory
correctly in the instance
items does not occur. No
document. Violations
error message is logged. As
might occur if a required
a result, all items in the step
attribute is missing or if
Output become optional.
an element appears out
of order in a sequence
Log per Occurrence; Log per
content.
Document
Error messages are logged.
Parsing continues, even
though data is missing. As a
result, all items in the step
Output become optional.

List has invalid number
of occurrences

ID values are not unique

The number of
occurrences must be
between the value of the
MinOccurs attribute and
the MaxOccurs attribute,
as defined in the
schema.

Each document must
have a unique ID.

Actions

Reject

The ParsingStatus item,
which is added as a new
group to the step Output
for the XML Parser step, is
set to False and includes the
corresponding error
message.

Fatal

A missing mandatory item
causes the job to fail.

Ignore No error message is logged.
Log per Occurrence; Log per
Document
Error messages are logged.
Reject

The ParsingStatus item,
which is added as a new
group to the step Output
for the XML Parser step, is
set to False and includes the
corresponding error
message.

Fatal

If the list has invalid
number of occurrences, the
job fails.

Ignore No error message is logged.
Log per Occurrence; Log per
Document
Error messages are logged.
Reject

The ParsingStatus item,
which is added as a new
group to the step Output
for the XML Parser step, is
set to False and includes the
corresponding error
message.

Fatal

Duplicate ID values cause
the job to fail.
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Large scale parallel parsing
Improve the performance of jobs that parse large files that have a structure that
contains many repeating elements.
The XML stage enables the parallelism by processing different parts of the XML
document in parallel on different processors, thereby significantly reducing the
time required to run the job. Parallel processing is optimal for XML documents
that have a small header and footer and a large body that contains many repeated
elements. Many documents that are larger than 1 GB exhibit this type of structure.
The following figure shows an example of this type of document:

In the above example, multiple subtrees are rooted at the /Company/Customers/
Customer node. The data that appears before the first occurrence of the
/Company/Customers/Customer node constitutes the header context. The body
consists of all of the subtrees rooted at the /Company/Customers/Customer node.
The footer consists of the data that appears after the close of the last
/Company/Customers/Customer node. Assume that in the XML document, the
/Company/Customers/Customer subtree repeats 1 million times.
If the parallel engine is configured for 4 nodes, the parallel parser partitions the
XML document into four partitions, each of which contains approximately 250,000
subtrees. The exact number of subtrees in each partition might vary, depending on
the presence of CDATA or comments sections. To help XML stage create the right
partitions, you specify the XML path to the body of the XML document. For
example in the above document the XML path to the body is /Company/
Customers/Customer. Each process applies the assembly on the entire document,
but skips the data that is not part of is designated partition. The result of all of the
processes is collected and passed to the next stage.
Because of the partitioning, if steps that are after the parallel parser step requires
the entire set of data from the partition path, the parallel parser cannot compute a
partition path. If a list above the partition path is mapped to the output, multiple
duplicate rows are generated for each process. Therefore, the parallel parser is not
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enabled. If the XML document does not contain repeating elements, you cannot
use parallel parsing. If there are two repeating elements in the XML document that
are not in an ancestor-descendant relationship but instead map to the output links,
the parallel parser is not enabled because parsing this structure in parallel causes
duplicate rows in the output links.
Keep in mind that if the XML document does not contain repeating elements, you
cannot use parallel parsing. In this example, the repeating element is
/Company/Customers/Customer. If the XML document has multiple types of
repeating elements, you cannot use parallel parsing. For example, if the XML
document has two repeating elements /Company/Customers/Customer and
/Company/Suppliers/Supplier and the job is accessing multiple
/Company/Customers/Customer subtrees as well as multiple
/Company/Suppliers/Supplier subtrees, then the assembly cannot be parallelized.
Note that if the job is accessing multiple /Company/Customers/Customer
subtrees but is only accessing a single /Company/Suppliers/Supplier subtree, then
the /Company/Suppliers/Supplier is considered to be part of the footer context,
and the assembly can then be parallelized.
Parallel parsing does not work if the XML body contains a recursive definition. For
example, if the XML body is /Company/Customers/Customer, parallel parsing
will not work if there is a “Customer” present below /Company/Customers/
Customer. However, it will work if there is a “Customer” node before the first
occurrence of /Company/Customers/Customer – for example, in the header
context or in the footer context.

Configuring parallel parsing
Jobs that process XML data that has many repeating elements benefit from parallel
parsing.

Procedure
1.
2.
3.
4.
5.
6.

Double-click the XML stage on the canvas to open the stage editor.
On the Advanced tab set the Execution mode to Parallel.
Select the input link and then on the Partitioning tab, select Entire.
Open the Assembly Editor and click to display the XML Parser step.
Make sure that the assembly does not have any errors.
Open the Parallel Parsing section, and click Compute to generate the XML
partition path. The Compute button is available only if the assembly is valid. If
you modify the assembly after you generate the XML partition path, you must
recalculate the partition path. If you do not recalculate the path, the stage fails
in runtime. If you press the button and a path is not generated, the current
assembly cannot be parallelized. For more information about the types of
assemblies that can and cannot be parallelized, see “Large scale parallel
parsing” on page 32.
Note: On the XML Source tab of Parser step, select Single file or File set to
use the parallel parsing feature. Parallel parsing does not work on string set.

Controlling how specific items are parsed
Pass data as a chunk, disable type derivation, or change a recursive item into a list
item.
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About this task
By default, the XML Parser step applies the schema that you specify to all items in
the schema. However, there might be situations when you do not want to apply
the schema to a specific item. To control how a specific item is parsed, you apply
one of the parsing options: Chunk, Disable Type Derivation, or Recursive to List.
To prevent data from being parsed, use the Chunk option. When you apply this
option to a schema item, all of the data for the item and its child items, if there are
any, is concatenated into a single string; and that string is passed as a chunk to the
next step or stage. The Chunk option is useful when the data that you want to
parse is inconsistent with the schema. In this case, you can pass the data as a
chunk and in a subsequent step or stage, parse the chunk. Another use for the
Chunk option is when you want to apply validation rules to only a specific section
of a document. In this case, you pass the data as a chunk, and then in a
subsequent XML Parser step, you configure validation rules that apply specifically
to that chunk.
To prevent the schema tree from becoming unnecessarily complex and to optimize
processing, use the Disable Type Derivation option. An XML schema can contain
derivations. For example, a derivation occurs when the schema defines a base
element and also defines a child element that inherits, or derives, attributes from
the base element. By default, when the XML Parser step creates the schema tree,
the tree includes all of the attributes that all of the child elements inherit from the
base elements. This schema enrichment ensures that no information about the
element is lost. If you know that you do not need the child elements in the data,
you can select the base element in the schema and disable type derivation.
To turn a recursive type into a list of items, use the Recursive to List option. The
attributes recursiveParentReferenceID and recursiveID are added to the schema to
maintain the relationship via unique keys that the parser generates. The
recursiveID is a unique key for each parent of the recursion. The
recursiveParentReferenceID attribute stores the key for the parent of each child.

Procedure
1. In the Document Root window of the XML Parser step, right-click the item to
which you want to apply a parsing option.
2. From the menu that displays, select the parsing option.

Setting default values for types
Specify a default value for the XML Parser to use when the schema does not define
a default value for a type.

Procedure
1. From the Assembly Editor, click Administration and then select Default Data
Type Values.
2. Enter default values.
3. On the XML Parser step, open the Validation window and set the Use global
default values for missing values rule to True.

XML Composer step
Use a specified structure to compose XML content.
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XML Target
Write to File
Enter the output directory and the file name prefix for the files that will be
composed, or click Insert Parameter and then select the name of the
parameter for the output directory and file name prefix. The parameters
that are available are those that you previously defined in the job and the
built-in macros that are in IBM InfoSphere DataStage.
Pass as String
Pass the composed XML string to a downstream step or stage for further
processing.
Pass as Large Object
Pass the composed XML string as a large object. The final target stage –
that is the last stage in the job – must be a LOB-aware stage, such as the
DB2 connector, Oracle connector, ODBC connector, Teradata connector, or
Websphere MQ connector. These stages use the LOB locator string to
obtain the XML data and then write it to the target database or message
queue. The job can contain non-LOB-aware stages, but these stages must
not modify the LOB locator string. If the last stage in the job is not
LOB-aware, the LOB locator is written out as data, rather than being
interpreted as a locator.

Document Root
Select the top-level element that describes the documents that you are composing.
The types that display under the library's namespace are top-level element
definitions. Following the XML Schema standard, only top-level elements can
describe documents. The name of the element that you select must match the
top-level element name in the instance documents. For example, if you are
composing Order documents, you select the Order element. When you select the
element, you can view its structure and verify that the structure is correct for the
documents that you want to compose.
Note: The elements from which you select the document root are from the
resources that were previously imported into the schema libraries. If you need to
import the resource that contains the document root for the XML Composer step,
click the Libraries tab and import the resource that you need. Then return to the
Assembly Editor and configure the document root.

Validation
By default, the XML Composer uses strict validation, and the job fails if a violation
occurs. To customize validation, specify the action to perform when a violation
occurs.
For more information about validation rules, see “XML Composer validation rules”
on page 36.

Mappings
Create a mapping to the document_collection item. How you map this item
determines whether one document or multiple documents are created. To produce
only one document, map the root of the Input (top) to document_collection. To
produce multiple documents, map a list item to the document_collection item.
Then one file will be created for each item in the list. For more information about
XML transformation
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mapping, see “Working with the mapping table” on page 17.

Header
Specify additional optional information to include at the beginning of the XML
output.
Generate XML fragment
Do not include the XML declaration, comments, and processing
instructions.
Include XML declaration
Include the XML declaration, for example, <?xml version="1.0"
encoding="UTF-8">.
Include comments
Include the comments that you enter in the Comments field.
Include processing instructions
Include the processing instructions that you enter in the Processing
Instructions field. Enclose each processing instruction in the <? and ?>
tags.

Format
Encoding type
Select the encoding to use for the document. The default encoding is
UTF-8.
Format style
Check the box to apply the following format options to the XML output:
v Indentation length – Select the number of characters to use for each
indentation level in the XML output.
v New line style – Select the type of new line. Choices are UNIX (LF),
DOS(CRLF) or MAC(CR).
v Omit attributes – For attributes that have default values and are in the
data or for attributes that have fixed values, omit the values from the
XML output.
v Omit null elements – For nullable elements that are not in the data,
omit the elements from the XML output.
For examples the use the XML Composer step, see Example 2 and Example 3.

XML Composer validation rules
By default, the XML Composer uses strict validation, and the job fails if a violation
occurs. To customize validation, specify the action to perform when a violation
occurs.
The following tables describe the validation rules and the applicable actions.
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Table 11. Value validation rules
Rule

Description

Data type has illegal value

The value must match the
value rules for the data type
of the corresponding item.

Actions
Ignore Type-checking and
type-conversion are
not performed. The
data types of the
items in the Target
column of the
mapping table are
replaced with the
String data type.
Log per Occurrence; Log per
Document
Type-checking is
performed. If a type
fails the check, a log
error is reported
either once for each
occurrence or once
for the entire
document; however,
parsing continues.
Type-conversion is
not performed. The
data types of the
items in the Target
column of the
mapping table are
replaced with the
String data type.
Fatal

Value fails facet constraint
Note: If you enable this
rule, the “Datatype has
illegal value” rule is also set
to the same action that you
choose for this rule.

The value is checked against
the facets of its
corresponding item type.

(Default)
Type-checking and
type-conversion are
performed. An
invalid value causes
the job to fail.

Ignore Facet-checking is
not performed.
Log per Occurrence; Log per
Document
Facet-checking is
performed. Errors
are logged.
Fatal

(Default)
Facet-checking is
performed. An
invalid value causes
the job to fail.
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Table 11. Value validation rules (continued)
Rule

Description

Item than cannot be null has
a null value

Non-nullable items are
checked to ensure that they
do not contain null values.

Actions
Ignore Null-checking is not
performed. All items
in the Target column
of the mapping
table become
nullable.
Log per Occurrence; Log per
Document
Null-checking is
performed, and
errors are logged.
Null values are set.
As a result, all items
in the Target column
of the mapping
table become
nullable.

Trim values
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Trim the white space before
and after a value before
performing type-checking
and type-conversion.

Fatal

(Default)
Null-checking is
performed. An
invalid value causes
the job to fail.

False

Trimming is not
performed.

True

(Default) Trimming
is performed on
both sides of the
value.

Table 12. Structure validation rules
Rule

Description

Mandatory items are missing Items must appear correctly
in the instance document.
Violations might occur if a
required attribute is missing
or if an element appears out
of order in a sequence
content.

Actions
Ignore (Default) Checking
for mandatory items
does not occur.
Error messages are
not logged. As a
result, all items in
Target column of the
mapping table are
optional and you do
not need to provide
a mapping for them.
Log per Occurrence; Log per
Document
Error messages are
logged. Missing
values are not filled
in. As a result, all
items in the Target
column of the
mapping table are
optional.
Fatal

List has invalid number of
occurrences

A missing
mandatory item
causes the job to
fail.

The number of occurrences
Ignore No error message is
must be between the value of
logged.
the MinOccurs attribute and
the MaxOccurs attribute, as
Log per Occurrence; Log per
defined in the schema.
Document
Error messages are
logged.
Reject

The
ComposingStatus
item, which is
added as a new
group to the step
Output for the XML
Composer step, is
set to False and
includes the
corresponding error
message.

Fatal

If the list has invalid
number of
occurrences, the job
fails.

Transformation steps for the XML stage
Transformation steps for the XML stage are available from the palette in the
Assembly Editor.
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Aggregate step
Perform hierarchical aggregations on the items in a list.
In the example below, the aggregate function, average, is computed for the salary
of all employees in each department. The departmentID is used as the key to
group Employee items and the averageSalary is computed for each group. The
result list contains an item for each distinct departmentID/grouping.
Company[]
Employee[]
departmentID
salary
result[]
keys
departmentID
aggregate
averageSalary

List to Aggregate
Specify the list that contains the elements that will be iterated on.
Scope Select the item that defines when to produce the result of the aggregation.
Aggregation Item and Aggregation Function
Select an items and the function to use for the aggregation. The function
that you select must be applicable to the data type of the selected item.
The following table describes the available aggregation functions.
Table 13. Aggregation functions
Function

Description

Average

Calculates the average value in the list.

Count

Counts the elements in the list. Ignore null
values.

Concatenate

Concatenates all strings in the list, starting
with the first element.

First

Selects first value in the list.

Last

Selects last value in the list.

Maximum

Selects the maximum value in the list. If the
list contains Boolean strings, True is greater
than False.

Minimum

Selects the minimum value in the list. If the
list contains Boolean strings, False is less
than True.

Sum

Calculates the sum of all of the values in the
list.

Variance

Calculates the variance value of all of the
values in the list.

Aggregation Keys
Specify aggregation keys to produce multiple aggregation rows for each
unique key value.

H-Pivot step
Transpose a list into a set of items, based on a key.
Scope Specify the list to transform.
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Columns
Specify the columns to convert into rows. For each column that you
specify, a new record is created.

HJoin step
Transform the items from two lists into one nested list.
Parent List
Specify the parent list. The parent list cannot already have a containment
relationship with the child List.
Child List
Specify the child list.
Optimization Type
If all of the records have the same key and are consecutive to each other,
select In-memory as the optimization type.
Parent Keys
Specify the key to use to join the lists.
Child Keys
Specify the key to use to join the lists.
For an example of using the HJoin step, see .Example 3

Order Join step
Join items based on their position in two lists.
Select two lists to join into one list. The items in each list are joined, based on their
position in the list. For example, item 1 in list 1 is joined to item 1 in list 2. If one
list has fewer items than the other list, items that have a null value are added to
the shorter list.

Regroup step
Use the Regroup step to create a parent-child list relationship from a single list.
Remove redundancy in a data set by using the Regroup step to transform the
items in one list into nested list. Identify items that contain redundant data and
move them into a parent list. Identify child items to move in to a child list.
List to regroup
Select the list to regroup.
Scope Select the scope.
Parent and Child Items
Drag items to identify which belong to the parent list and which belong to
the child list.
Keys

Specify one or more keys to use for the regroup operation. For each unique
instance of a key field, a separate entry is made in the list.

Input records of regroup lists are clustered by key – optimize execution
If the input records have already been sorted by the selected key, select this
option to improve performance.
For an example that includes the Regroup step, see Example 2.
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Sort step
Sort the items in a list by one or more keys.
List to Sort
Specify the list to sort.
Scope Specify the scope.
Data set fits into memory; optimize sort
Select this option to improve performance.
Keys and Order
Specify one or more keys by which to sort the values, and specify the sort
order for each key.

Switch step
Use the Switch step to classify items into one or more new target lists, based on
constraints that you specify.
Each target list is associated with a constraint. The target list contains all of the
items that passed the constraint. The Default list contains all of the items that
failed all of the constraints.
To create a new target list and one or more constraints, click Add Target.
The following table describes the functions that you can use to create a constraint:
Table 14. Functions for the Switch step
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Function

Type

Description

isNull

All types

Returns True if the value is
null.

Greater than

Any number

Returns true if the value is
greater than the value of the
parameter.

Greater than or equal

Any number

Returns true if the value is
greater than or equal to the
value of the parameter.

Less than

Any number

Returns true if the value is
less than the value of the
parameter.

Less than or equal

Any number

Returns true if the value is
less than or equal to the
value of the parameter.

Equals

All types

Returns true if the two
values are the same.

Between

Any number

Returns true if the value is
within the specified range.

IsTrue

Boolean

Returns true if the value is
true.

IsFalse

Boolean

Returns true if the value is
false.

Compare

String

Returns true if the string
value is the same as the
string value of the parameter.
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Table 14. Functions for the Switch step (continued)
Function

Type

Description

CompareNoCase

String

Returns true if the string
value is the same as the
string value of the parameter.
Ignores the case.

Contains

String

Returns true if the string
value contains the string
value of the parameter.

ContainsCaseInsensitive

String

Returns true if the string
value contains the string
value of the parameter.
Ignores the case.

IsBlank

String

Returns true if the string is
empty or null.

IsNotBlank

String

Returns true if the string is
not empty and not null.

Like

String

Returns true if the string
value matches the pattern
defined by the parameter
value. Use a percent sign (%)
to define missing letters
before and after the pattern.

Union step
Use the Union step to combine two lists that have different structures into a single
list that has a predefined structure.
On the Union Type tab, you select the target list schema. On the Mappings tab,
you map the two lists.

V-Pivot step
Use the V-Pivot step to transform records into fields of another record.
You define the record source and scope. For each column name, the step output
contains a branch with a single item that has the same structure as the step input.
Based on the value of the Source of Column Names field, the record is classified
into the correct branch.

Examples of transforming XML data
Build these sample jobs that parse and compose XML data.
The examples all use one data file, departments.xml, and two schemas
(Employee.xsd and Organization.xsd). You can create each example yourself, by
following the step-by-step instructions, or you can import the finished job and
explore it on your own. The data for the examples is an XML file that contains
information about the employees in one department of a company. The schemas
define the structure for the employee information and for the department
information.
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If you are just getting started with the XML stage, begin by building Example 1,
which includes tasks that illustrate the use of the Assembly Editor and the Schema
Library Manager.
To get the files for the examples, go to http://www.ibm.com/support/
docview.wss?uid=swg27019894.

Example 1: Parsing XML data
Create a simple job that uses the XML stage and the XML Parser step to parse
employee data, which is stored in one XML data file, into two flat files.

About this task
This basic parsing example uses the sample XML data file, departments.xml, and
the sample schemas, Employee.xsd and Organization.xsd, to illustrate parsing
source data from one XML file into two files. The departments.xml file contains
information about the employees of one department in a company. In this example,
you parse the XML data into two files. One file contains employee business
information: employee name, date of hire, date of birth, gender, title, employee ID
and department ID. The second file contains employee address information:
employee ID, street, city, state, postal code, country, and address type.
To create the example, complete these tasks:

Example 1: Creating the job
Create the example job that includes one XML stage and two Sequential File
stages.

About this task
The following figure shows the job that you create for the parsing example. The
job includes one XML stage, named Departments, and two Sequential File stages,
named Employee_File and Address_File. The Departments stage is linked to the
Employee_File stage by a link named Employee, and it is also linked to the
Address_File stage by a link named Address.

Procedure
1. Start the IBM InfoSphere DataStage and QualityStage Designer client.
2. In the Repository pane, right-click the Jobs folder, and select New > Parallel
job.
3. Open the Real Time section of the palette, and drag one XML stage to the
canvas.
4. Perform the following steps to create a job property for the location of the
example files:

44

XML Transformation Guide

a. Choose Edit > Job Properties.
b. On the Parameters tab, in the Parameter Name field, enter
xml_example_root_folder and then specify the following values:
Table 15. Specifying the values for field names
Field name

Value

Prompt

Root of example folder tree

Type

String

Help Text

Point to the root of the file tree folder

Each example uses this job parameter.
5. Open the File section of the palette, and drag two Sequential File stages to the
canvas. Position these stages to the right of the XML stage.
6. Create a link from the XML stage to each sequential file stage.
7. Rename the stages and links as shown in the following table:
Table 16. Names for job elements
Element

Name

XML stage

Departments

Sequential File stage

Employee_File

Sequential File stage

Address_File

Link from Departments to Employee_File

Employee

Link from Departments to Address_File

Address

8. By looking at the departments.xml file, which contains the XML data, you
determine which columns to create to hold the employee data that the XML
stage will pass to the Employee_File stage and the Address_File stage.
Double-click the Employee_File stage to open the stage properties. Then click
the Columns tab, and configure the following columns:
Table 17. Columns for the Employee_File stage
Column name

SQL type

Length

LastName

VarChar

40

MiddleName

VarChar

40

FirstName

VarChar

40

Gender

VarChar

BirthDate

Date

Title

VarChar

HireDate

Date

EmployeeID

VarChar

DepartmentID

VarChar

The column names that you create closely resemble the names of the XML
schema elements. In the Output step of the assembly, where you configure the
mapping between target items and source items, you will see how name
similarity affects the mapping suggestions that are returned.
9. Click the Properties tab, and configure the following properties that define the
output file:
XML transformation
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Table 18. Configuring the properties
Field name

Value

Target > File

Enter the path where you want the output
file to be created, followed by the file name
employee.txt.

Target > File Update Mode

Choose Overwrite to create the file.

First line is column name

Set to True.

10. Click OK to close the Employee_File stage.
11. Double-click the Address_File stage. On the Properties tab, configure the
following properties that define the output file:
Table 19. Configuring the properties
Field name

Value

Target > File

Enter the path where you want the output
file to be created, followed by the file name
address.txt.

Target > File Update Mode

Choose Overwrite to create the file.

First line is column name

Set to True.

12. For the Address_File stage, do not create any columns now. You will later use
the Assembly Editor to propagate those columns automatically.
13. Click OK to close the stage properties.
14. Choose File > Save, and name the job as xml_parser_example.

Example 1: Opening the Assembly Editor and viewing the issues
For each XML stage, you open the Assembly Editor, which you use to define an
XML transformation within the context of a job.

About this task
Using the Assembly Editor, you create an assembly. An assembly contains a series
of steps that parse, compose, and transform hierarchical data. By default, an
assembly contains an Overview, an Input step, and an Output step. You add
additional steps to the assembly, based on the type of transformations that you
want to perform. In this example, you add one XML_Parser step to parse XML
data into two output Sequential File stages, Employee_File and Address_File.

Procedure
1. To open the Assembly Editor, double-click the Departments stage on the
canvas. The XML stage editor opens. From the XML stage editor, click Edit
assembly to open the Assembly Editor.
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2. The Assembly Outline displays the steps in the assembly. This assembly
requires an XML Parser step. Click Palette to open the palette and then
double-click the XML Parser step to add it to the outline. Because this is the
first step that you are adding to the assembly, the step is automatically added
between the Input step and the Output step. When you add another step, first
select the step above which you want the new step to be located, and then
double-click the step in the Palette. The new step is added below the selected
step.
3. Now you have created the basic assembly structure, but you still need to
configure the steps in the assembly. Before you perform the configuration,
notice that in the outline, an error icon (a red exclamation mark) displays
beside the XML Parser step and the Output step. The error icon indicates that
you must address one or more issues in that step. The total number of issues
appears in the upper-right corner of the Assembly Editor. To view the issues
list, click View All. The following figure shows the issues for this assembly:
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The XML Parser step has two errors, indicating that you must complete two
mandatory fields. The Output step has 12 errors. Notice that the errors that
require mandatory input are for the output links Employee and Address and
the columns that you defined on the Employee link. These links and columns
are listed as errors because you have not yet mapped the hierarchical structure
of the assembly back to a relational structure. The first error in the Output list
indicates the no columns were defined on the Address link. For now, you can
ignore these errors; you will correct them when you create mappings in the
Output step.
4. Close the issues list.

Example 1: Importing the schemas for the examples
Use the Schema Library Manager to import the example schemas into a library.

About this task
You must import the schemas that the example job uses. Imported schemas are
stored in the metadata repository, where they are available for use in any assembly
that you create.

Procedure
1. From the Assembly Editor, click the Libraries tab to open the Schema Library
Manager. The Schema Library Manager is available from the Assembly Editor
and from the IBM InfoSphere DataStage and QualityStage Designer client. From
the InfoSphere DataStage and QualityStage Designer client, you choose Import
> Schema Library Manager.
2. To create a library for the example schemas, click New Library. For the library
name, enter Schemas_for_XML_examples. For the category, enter Examples. The
library is now categorized under Examples. If you have additional example
schemas, you can add them to this library or create a new library for them; all
of your example schemas can be categorized under the Examples category.
3. Expand the Examples category, select Schemas_for_XML_examples, and then
click Import New Resource. Find the Employee.xsd and Organization.xsd,
import both into the library.
Note: Multiple .xsd files can be imported at a time into the library. This can be
done by selecting multiple files in the browse window on clicking Import New
Resource.
4. Click the Assembly Editor tab to return to the assembly.

Example 1: Configuring the Overview
The Overview provides creation and modification information about the assembly
and includes a Description field that you can modify.

About this task
On the Overview, you can enter an optional description for the assembly. This field
documents the purpose of the assembly and is helpful when you or others later
need to modify the assembly.

Procedure
In the Description field, enter the following description: This assembly uses the
Organization.xsd and Employee.xsd schemas. The assembly parses the
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departments.xml data file and sends the output to two files named
address.txt and employee.txt.

Example 1: Configuring the XML Parser step
Configure the location of the XML source data and the schema that you want to
use to parse it.

Procedure
1. Click the XML Parser step in the outline. By default, the Configuration tab for
the step opens. The following figure shows the Configuration tab for the step:

2. On the XML Source tab, you specify the location of the XML source data. In
this example, the XML source data is in the single file departments.xml. Select
Single file, and then click Insert Parameter and select the
xml_example_root_folder parameter. You will specify the exact location of the
file when you run the job. You can also specify the absolute path to
departments.xml.
3. On the Document Root tab, you select the schema element that describes the
documents that the step parses. Click Browse. Open the
Schemas_for_XML_examples library, which is the library into which you
imported the Organization.xsd and Employee.xsd schemas.
4. Click to open the Organization.xsd schema, click the root element
departments, and then click OK. The Document Root tab displays the structure
of the schema. The step Output also displays this same structure.
5. On the Validation tab, select Strict Validation. By selecting Strict Validation,
you automatically ensure that the data types conversion is performed. If you
use the default Minimal Validation, all data types are automatically converted
to the String type.

Example 1: Configuring the Output step
In the Output step, create mappings that define how to map source items in one
data structure to target items in another data structure.

About this task
In this assembly, you use the Output step to map a hierarchical data structure to a
relational data structure.
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Procedure
1. Click the Output step in the Assembly Outline to open the step. The step
displays the Output window of the Configuration tab. In the Output window,
the output table describes the data structure that is the output of the assembly.
The following figure shows the relevant columns of the output table for this
assembly:

The default view in the Output window is the Links view. The Links view
looks similar to the table that displays on the Columns tab in the XML stage
editor. The output structure for Employee link is shown. Notice that the
columns that you defined in the XML stage editor display in the output table.
In the Links view, you can modify the columns that you already defined. Any
changes that you make to the columns are propagated to the column
definitions in the XML stage properties.
2. From the Output Links drop-down list, select Address. The following figure
shows that the output table does not display any columns because when you
created the job, you did not define any columns for the Address link. The lack
of columns is not an error. However, if no columns are defined on the link,
you cannot map any source items in the hierarchical data structure to this
link. Because this job is designed to produce a file that contains address data,
you need to create the address columns. But instead of returning to the job
and manually creating columns, you can automatically create them from the
Mappings tab of the Output step.

3. Click the Mappings tab. The following figure shows the mapping table. In
this table, each item in the output structure is represented by a row in the
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table. You map target items to source items. For this job, the target structure is
two links, Address and Employee, and the columns that are defined on those
links. In the Target column, the Employee link is represented as a list item.
Under the Employee list item, each column displays as a content item.

4. To create mappings, first map target list items to source list items. Then map
target content items to source content items. There are four ways to specify a
mapping: use automatic mapping, select a mapping candidate from a list of
valid mapping candidates, select a mapping candidate from the entire source
structure using More option in the drop-down list, or specify a constant value
as the mapping using Constant option in the drop-down list.
5. Select the Employee list item from the Target column. In the Source column,
click and choose employee from the drop-down list. Click Auto Map.
Automatic mapping is context-sensitive, it creates a mapping for the selected
item and all of its descendent items. Each source item that is automatically
mapped is determined based on similar name and data type.
The following figure shows the result of Auto Map for the Employee list item.
The target Employee list item and all of its child items are automatically
mapped to source items. If the Employee list item had a descendent list that
contained content items, the descendent list and all of its content items would
also be automatically mapped.

6. In this example, the target item, BirthDate is wrongly mapped to the source
item, hireDate. You need to manually create the correct mapping. Click
hireDate in the source list to choose the correct item from the drop-down list.
The items in the list appear in order, from highest to lowest, based on their
mapping similarity. Select dateOfBirth as the right candidate for the target
item, BirthDate from the drop-down list.
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7. Next you need to map the Address list item from the Target column. In the
Source column, click and choose Address from the drop-down list and click
Propagate.
Propagate automatically creates one column for each item that is a descendent
of the Address item in the source structure and automatically maps those
items to the respective items in the source column. When you use the
Propagate button to create items, the items are automatically mapped. The
following figure shows the result:

8. Look at Address item in the target structure. The child items describe the
address of an employee; however, the structure does not currently contain any
way of identifying that employee. To make the resulting data useful, you need
to add a column that identifies the employee. You can define a new column
directly in the Output step. Then when you save the assembly, the column is
automatically propagated back to the Address link in the job. To relate the
Employee to each Address, create an EmployeeID field in the Address list.
Follow these steps:
a. Open the Output window on the Configuration tab.
b. In the Output Links field, choose Address. The columns that are mapped
to the Address link display in the table.
c. Click the first empty row at the bottom of the table where Click to add is
displayed. Enter the item, EmployeeID in the Name field.
d. Choose VarChar in the Type field.
9. Next you must map a source item to the new target item, EmployeeID. Click
and open the Mappings window. You will see that the EmployeeID is added
to the Address list in the Target column. Manually map the EmployeeID in the
source column to the EmployeeID in the Address list of target column. In the
Source column, click and choose employeeID from the drop-down list.
If you do not see the items in the drop-down list, click More to find the
required item. The following figure shows the result of mapping:
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10. Click OK to save your work and return to the XML stage editor. Click the
Address link in the preview window, and then click the Columns tab to see
that the EmployeeID column that you just created has been propagated back
to the job. The following figure displays the preview window.

11. Click OK to close the stage editor.

Example 1: Viewing the output of the job
After you run the parsing job, open the text files, and look at the output.
XML transformation
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Procedure
1. From the Assembly Editor, click OK to return to the XML stage editor. Then
click OK to close the XML stage editor.
2. From the IBM InfoSphere DataStage and QualityStage Designer client, choose
File > Compile to compile the job.
3. Choose File > Run to run the job.
4. In the parameter window, for the first parameter, Root of example folder tree,
enter the path of the directory where you have unzipped your examples zip
file. For example, if you have downloaded and saved the examples zip file in
the directory, C:\Examples, enter this directory as the Value for the first
parameter, Root of example folder tree.
The following is an example input file that contains the employee and address
information:
- <department xmlns="" departmentID="A100" departmentKind="Division">
<manager>A7100</manager>
- <ns1:employees>
- <ns1:employee employeeID="A8990" departmentID="A100">
- <name>
<firstName>Zen</firstName>
<middleName>P</middleName>
<lastName>Wright</lastName>
</name>
<gender>male</gender>
<dateOfBirth>1980-04-04</dateOfBirth>
<title>Mr</title>
- <Address>
<street>2301 East Lamar Blvd</street>
<city>Arlington</city>
<state>Texas</state>
<country>USA</country>
<postalCode>78363</postalCode>
<address_type>O</address_type>
</Address>
- <Address>
<street>2001 West Street</street>
<city>Arlington</city>
<state>Texas</state>
<country>USA</country>
<postalCode>78300</postalCode>
<address_type>H</address_type>
</Address>
<hireDate>2008-07-11</hireDate>

5. After the job runs, open the address.txt file and the employee.txt file to look
at the results.
The address.txt file contains this data:
"employeeID","street","city","state","country","postalCode","address_type"
"A8990","2301 East Lamar Blvd","Arlington","Texas","USA","78363","O"
"A8990","2001 West Street","Arlington","Texas","USA","78300","H"
"B6540","San Felipe, Suite 2400.","Houston","Texas","USA","77057","O"
"B6540",""53rd West Street.","Houston","Texas","USA","77000","H"
"C1230","5th South Street.","Miami","Florida","USA","32599","O"
"C1230","54th South Street","Miami","Florida","USA","32501","H"

The employee.txt file contains this data:
"LastName","MiddleName","FirstName","Gender","BirthDate","Title","HireDate",
"EmployeeID","DepartmentID"
"Wright","P","Zen","male","1980-04-04","Mr","2008-07-11","A8990","A100"
"Donald","P","Cynthia","female","1987-01-17","Miss","2000-07-25","B6540","A100"
"William","G","Tania","female","1980-01-17","Miss","2002-07-25","C1230","A100"

You can now expand or modify this example. If you look closely at the sample
XML data file, you see that you can add two additional Sequential File stages
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to the job. One might store job information about each employee, such as start
date and salary; and second might store information about each department,
such as the department name, department type, and manager. After you learn
the basics of parsing by going through this basic example, you might want to
modify the job and the assembly to include these additional stages.

Example 2: Using the XML Composer and Regroup steps
Build this job that uses the XML stage and the Regroup and XML Composer steps
to create a XML file from two relational files.

About this task
This basic composing example uses two relational data files, employee.txt and
address.txt, and the sample schemas, Employee.xsd and Organization.xsd, to
illustrate composing source data from two relational files into one XML file. The
employee.txt file contains information about the employees of one department in a
company: employee name, date of hire, date of birth, gender, title, department ID,
and employee ID. The second file contains employee address information: street,
city, state, postal code, country, address type (home or office), and employee ID.
Each employee has two addresses, a home address and an office address. In this
example, you use a Join stage in the job to join the two tables. Then you use the
XML Stage and the Regroup and XML Composer steps to compose a XML file that
contains each employee's information, followed by the employee's two addresses.
In Example 3: Using the XML Composer and HJoin steps, you compose the same
output file, except instead of using a Join stage in the job, you use an HJoin step in
the assembly. Using an HJoin step is an alternative approach to using a Join stage
in the job itself.
You can follow these steps to build the job, or you can look at the completed job,
which is named xml_composer_example.dsx. To look at the completed job or use it
as the starting point for expanding the example, import the job into IBM
InfoSphere DataStage.
To create the example, complete these steps:

Example 2: Creating the job
Create the example job that includes two Sequential File stages, a Join stage, and
an XML stage.

About this task
The following figure shows the job that you create for the composing example. The
job includes two Sequential File stages that are named Employee_File and
Address_File. These Sequential File stages are linked to a Join stage by two links
that are named Employee and Address. The Join stage is linked to an XML stage
by a link that is named Joined_Data.
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Procedure
1. Start the IBM InfoSphere DataStage and QualityStage Designer client.
2. In the Repository pane, right-click the Jobs folder, and select New > Parallel
job.
3. Open the File section of the palette, and drag two Sequential File stages to the
canvas.
4. Open the Processing section of the palette, and drag a Join stage to the
canvas. Position the Join stage to the right of the two Sequential File stages.
5. Open the Real Time section of the palette, and drag one XML stage to the
canvas. Position the XML stage to the right of the Join stage.
6. Perform the following steps to create a job property for the location of the
example files:
a. Choose Edit > Job Properties.
b. On the Parameters tab, in the Parameter Name field, enter
xml_example_root_folder and then specify the following values:
Table 20. Specifying the values for field names
Field name

Value

Prompt

Root of example folder tree

Type

String

Help Text

Point to the root of the file tree folder

Each example uses this job parameter.
7. Create a link from each Sequential File stage to the Join stage, and create a
link from the Join stage to the XML stage.
8. Rename the stages and links as shown in the following table:
Table 21. Names for job elements
Element

Name

Sequential File stage

Address_File

Sequential File stage

Employee_File

Join stage

Join

Link from Address_File to Join

Address

Link from Employee_File to Join

Employee

Link from Join to XML Stage

Joined_Data

9. Configure the Employee_File stage. Double-click the Employee_File stage to
open the stage properties. On the Properties tab of the Output page, configure
the following properties:
Table 22. Configuring the properties
Field name

Value

File

Enter the path and file name of the file. For
the Employee_File stage, the file name is
employee.txt.

Read Method

Select Specific File(s).

First Line is Column Names

Select True.

10. Click the Columns tab, and create these columns:
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Table 23. Columns for the Employee_File stage
Column name

SQL type

Length

LastName

VarChar

40

MiddleName

VarChar

40

FirstName

VarChar

40

Gender

VarChar

BirthDate

Date

Title

VarChar

HireDate

Date

EmployeeID

VarChar

DepartmentID

VarChar

11. Configure the Address_File stage. Double-click the Address_File stage to open
the stage properties. On the Properties tab of the Output page, configure the
following properties:
Table 24. Configuring the properties
Field name

Value

File

Enter the path and file name of the file. For
the Address_File stage, the file name is
address.txt.

Read Method

Select Specific File(s).

First Line is Column Names

Select True.

12. Click the Columns tab, and create these columns:
Table 25. Columns for the Address_File stage
Column name

SQL type

Street

VarChar

City

VarChar

State

VarChar

Country

VarChar

PostalCode

VarChar

Address_Type

VarChar

EmployeeID

VarChar

13. Configure the Join stage. Double-click the stage to open the stage properties.
On the Properties tab of the Stage page, in the Key property, enter
EmployeeID. This column is in both input data sets and is used to identify
which data belongs to which employee. On the Mapping tab of the Output
page, drag the header bar of the Columns table to the Joined_Data table. All
of the input columns are automatically mapped to output columns. Click OK
to close the Join stage.
14. Choose File > Save, and name the job xml_composer_example.

Example 2: Creating the assembly
Use the Regroup step to create a parent-child hierarchy from a single list; then use
the XML Composer step to compose the XML file.
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Before you begin
Import the example schemas employee.xsd and organization.xsd. If you have
already built Example 1: Parsing XML data, you have imported the schemas as
part of that example. For more information about importing the schemas, see
Importing the schemas for the examples.

Procedure
1. Double-click the XML stage to open the stage properties, and then click Edit
assembly to open the Assembly Editor.
2. Open the Palette, and then double-click the Regroup step to add it to the
assembly.
3. Select the Regroup step, and then from the palette, double-click the XML
Composer step to add it below the Regroup step.
4. On the Overview, in the Description field, enter the following description: This
assembly uses the Organization.xsd and Employee.xsd schemas. The Regroup
step creates a hierarchical structure, where the employee information is
the parent and the employee address information is the child. The XML
Composer step composes the data and saves the output in a file named
employee_output.xml.
This assembly uses the default Input step, which shows the input columns that
the Join stage passed to the XML stage. You cannot modify the input columns,
but you can display them as either links or a tree. The following figure shows
the relational structure that the Input step provides to the Regroup step. The
structure is a flat list named Joined_Data:

Example 2: Configuring the Regroup step
Use the Regroup step to create a parent-child list from items that share the same
key.

About this task
To understand how the Regroup step works, first look at the output that the Join
stage produces. The Join stage uses the key field, EmployeeID, to join the tables in
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the two Sequential File stages into one table. Then for every unique combination of
fields, the Join stage produces one record, as shown below:
"LastName","MiddleName","FirstName","Gender","BirthDate","Title","HireDate",
"EmployeeID","DepartmentID","street","city","state","country","postalCode",
"address_type"
"Wright","P","Zen","male","1980-04-04","Mr","2008-07-11","A8990","A100",
"2301 East Lamar Blvd","Arlington","Texas","USA","78363","O"
"Wright","P","Zen","male","1980-04-04","Mr","2008-07-11","A8990","A100",
"2001 West Street","Arlington","Texas","USA","78300","H"
"William","G","Tania","female","1980-01-17","Miss","2002-07-25","C1230","A100",
"5th South Street.","Miami","Florida","USA","32599","O"
"William","G","Tania","female","1980-01-17","Miss","2002-07-25","C1230","A100",
"54th South Street","Miami","Florida","USA","32501","H"
"Donald","P","Cynthia","female","1987-01-17","Miss","2000-07-25","B6540","A100",
"53rd West Street.","Houston","Texas","USA","77000","H"
"Donald","P","Cynthia","female","1987-01-17","Miss","2000-07-25","B6540","A100",
"San Felipe Suite 2400.","Houston","Texas","USA","77057","O"

There are two records for each employee because each employee has two
addresses. To change this structure into a hierarchical structure, where there is one
record for each employee, and that record includes the two related addresses, you
use a Regroup step.

Procedure
1. On the Configuration tab of the Regroup step, configure these fields:
Table 26. Configuring the fields
Field name

Value

List to Regroup

Select top/InputLinks/Joined_Data. This is the list
that contains the items that you want to regroup.

Scope

Choose top.

2. In the Parent and Child Items window, you create the hierarchy for the list.
The items that you drag to the Parent Items list are those that are repeated
once for each record. The items that you leave in the Child Items list are those
that are subordinate to the parent fields and are repeated more than once. To
set up the correct structure for this assembly, drag LastName, MiddleName,
FirstName, Gender, BirthDate, Title, HireDate, EmployeeID, and DepartmentID
to the Parent Items list. Leave the Street, City, State, Country, PostalCode, and
Address_Type fields in the Child Items list.
3. In the Keys window, you specify the key to use for the regroup operation. For
each unique instance of the key field, a separate entry is made in the list. You
want a list of employees. Each record in the Join stage contains the EmployeeID
field, so that is the field to use as the key. Click the pencil icon in the Keys
window, and then select top/InputLinks/Joined_Data/EmployeeID.
4. The following figure shows the step Output of the Regroup step. The result of
the regroup is a list, called Regroup:result. This list contains the employee
fields as well as a child list, named Joined_Data, which contains the address
fields.
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To make the output tree a little easier to understand, rename the lists. Highlight
the Regroup:result item in the list, then right-click to display a menu of actions
that you can perform on items on the step output. Select Rename, and then
rename the list Employee. Then rename the Joined_Data item to be Address. At
any time, you can hover over the item name to display the original name. And
using the right-click menu, you can choose Reset to restore the original item
name.
5. Click OK to save the assembly. As you work on an assembly, it is important to
save your work regularly.

Example 2: Configuring the XML Composer step
Configure the XML Composer step to create a XML file that lists each employee
once, followed by the employee's two addresses.

Procedure
1. In the XML Target window of the XMLComposer step, choose Write to File. In
the Output Directory field, click Insert Parameter and choose
xml_example_root_folder. In the Filename Prefix field, enter the name of the
output file, which in this case is employee_output. Depending on how you
create the mappings, you can produce one file or create multiple files.
2. In the Document Root window, select the schema element that describes the
documents that the step composes:
a. Click Browse, and then open the Schemas_for_XML_examples library,
which is the library into which you imported the Organization.xsd and
Employee.xsd schemas.
b. Click to open the Employee.xsd schema, click the root element employees,
and then click OK. The Document Root tab displays the structure of the
schema.
3. Click the Validation tab. By default, validation for the XML Composer is set to
Strict. Set the validation to Minimal.
4. In the Regroup step, you established a hierarchical structure where the address
items are in a list that is a child of the employee list. Now on the Mappings
tab, map the items from the target schema to the items in the
Regroup:Employees list. The target schema contains some items that you will
not use. For example, the target schema contains a list named Job, which
includes items such as jobTitle and startDate. You do not need mappings to
items in the Job list because the Regroup:Employees list does not contain any
job items. To create the mappings, perform the following steps:
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a. The mapping for the document_collection item determines when a new
XML document is created. If you map the top element of the step Input to
document_collection, one document is created. If you map a list item to
document_collection, one document is created for each item in the list. The
name of each resulting file has the file name prefix that you specified on the
XML Target tab and an index that identifies the item from which the output
was created. In this case, top is automatically mapped to
document_collection; therefore, one document will be created.
b. Map top/Regroup:Employees in the Source list to the employee item in the
Target list, and then click Auto Map.
c. Using automatic mapping, you create the majority of the mappings that you
need, but you also create some mappings that you do not need. The Job list
item contains items that you do not need and that were automatically
mapped by choosing the best candidate for each item from the
Regroup:Employees list. You need to clear these mappings because you do
not need them. If you did not remove this mapping, a new file would be
created for each employee item in the input data. Select the Job item in the
Target list, and then click Clear Mappings to clear all of the mapped child
items.
d. Evaluate the mappings to confirm that they are what you want. Notice that
ns0:dateOfBirth in the Target list is mapped to top/Regroup:Employees/
Input:HireDate in the Source list. This mapping is incorrect. Click the arrow
on top/Regroup:Employees/Input:HireDate, and then select
top/Regroup:Employees/Input:BirthDate.
e. Make sure to map all the fields correctly and they are available in the
output. If you see the incorrect mapping in the Source column, click the
pencil icon in the Source list for that item, and then click More to display a
list of choices. Click and choose the appropriate field from the drop-down
list to map the item.
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Results
The following figure shows the results of the mappings:

The step Output contains a new node, named XML_Composer:result. This node
carries the path and file name for the output file during runtime.

Example 2: Viewing the output of the job
After you run the job, look at the output.

Procedure
1. From the Assembly Editor, click OK to return to the XML stage editor. Then
click OK to close the XML stage editor.
2. From the IBM InfoSphere DataStage and QualityStage Designer client, choose
File > Compile to compile the job.
3. Choose File > Run to run the job.
4. In the parameter window, for the first parameter, Root of example folder tree,
enter the path of the directory where you have unzipped your examples zip
file. For example, if you have downloaded and saved the examples zip file in
C:\Examples folder, enter this directory as the Value for the first parameter,
Root of example folder tree.
5. Open the employee_output.xml file to look at the results, which are shown
below. The resulting file contains a list of employees. For each employee, the
home and office addresses are shown. The type of address, home or office, is
identified by the address_type tag, which displays O for office address and H
for home address.
<?xml version="1.0" encoding="UTF-8"?>
<tns:employees xmlns:tns="Http://ibm.com/infosphere/xml/Employee">
<tns:employee employeeID="B6540" departmentID="A100">
<name>
<firstName>Cynthia</firstname>
<middleName>P</middlename>
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<lastName>Donald</lastName>
</name>
<gender>female</gender>
<dateOfBirth>1987-01-17</dateOfBirth>
<title>Miss</title>
<Address>
<street>San Felipe, Suite 2400</street>
<city>Houston</city>
<state>Texas</state>
<country>USA</country>
<postalCode>77057</postalCode>
<address_type>O</address_type>
</Address>
<Address>
<street>53rd West Street</street>
<city>Houston</city>
<state>Texas</state>
<country>USA</country>
<postalCode>77000</postalCode>
<address_type>H</address_type>
</Address>
<hireDate>2007-07-25</hireDate>
</tns:employee>
<tns:employee employeeID="B6540" departmentID="A100">
<name>
<firstName>Tania</firstname>
<middleName>G</middlename>
<lastName>William</lastName>
</name>
<gender>female</gender>
<dateOfBirth>1980-01-17</dateOfBirth>
<title>Miss</title>
<Address>
<street>5th South Street</street>
<city>Miami</city>
<state>Florida</state>
<country>USA</country>
<postalCode>32599</postalCode>
<address_type>O</address_type>
</Address>
<Address>
<street>54th South Street</street>
<city>Miami</city>
<state>Florida</state>
<country>USA</country>
<postalCode>32501</postalCode>
<address_type>H</address_type>
</Address>
<hireDate>2007-07-25</hireDate>
</tns:employee>
<tns:employee employeeID="A8990" departmentID="A100">
<name>
<firstName>Zen</firstname>
<middleName>P</middlename>
<lastName>Wright</lastName>
</name>
<gender>male</gender>
<dateOfBirth>1980-04-4</dateOfBirth>
<title>Mr</title>
<Address>
<street>2301 East Lamar Blvd</street>
<city>Arlington</city>
<state>Texas</state>
<country>USA</country>
<postalCode>78363</postalCode>
<address_type>O</address_type>
</Address>
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<Address>
<street>2001 West Street</street>
<city>Arlington</city>
<state>Texas</state>
<country>USA</country>
<postalCode>78300</postalCode>
<address_type>H</address_type>
</Address>
<hireDate>2008-07-11</hireDate>
</tns:employee>
</tns:employees>

Example 3: Using the XML Composer and HJoin steps
Build this job that uses the XML stage and the XML Composer and HJoin steps to
create a hierarchical structure.

About this task
This basic composing example uses two relational data files, employee.txt and
address.txt, and the sample schemas, Employee.xsd and Organization.xsd, to
illustrate composing source data from two relational files into a XML file. The
employee.txt file contains information about the employees of one department in a
company: employee name, date of hire, date of birth, gender, title, department ID,
and employee ID. The second file contains employee address information: street,
city, state, postal code, country, address type (home or office), and employee ID.
Each employee has two addresses, a home address and an office address. In this
example, you use an HJoin step in the assembly to join the two tables. Then you
use the XML Composer step to compose a XML file that contains each employee's
information, followed by the employee's two addresses.
The completed example job, xml_hjoin_example.dsx, is also available. To look at
the completed example or use it as the starting point for expanding the example,
import it into IBM InfoSphere DataStage.
To create the example, complete these steps:

Example 3: Creating the job
Build this job that uses the XML stage and the XML Composer and HJoin steps to
compose data into a hierarchical structure.

About this task
The following figure shows the job that you create for the composing example. The
job includes two Sequential File stages that are named Employee_File and
Address_File. These Sequential File stages are linked to an XML stage by two links
that are named Employee and Address. In this example, instead of using a Join
stage in the job to join the files into a list and a Regroup step in the assembly to
join the files into a nested list, you use the HJoin step in the assembly to perform
both actions.
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Procedure
1. Start the IBM InfoSphere DataStage and QualityStage Designer client.
2. In the Repository pane, right-click the Jobs folder, and select New > Parallel
job.
3. Open the File section of the palette, and drag two Sequential File stages to the
canvas.
4. Open the Real Time section of the palette, and drag one XML stage to the
canvas. Position the XML stage to the right of Sequential File stages.
5. Perform the following steps to create a job property for the location of the
example files:
a. Choose Edit > Job Properties.
b. On the Parameters tab, in the Parameter Name field, enter
xml_example_root_folder and then specify the following values:
Table 27. Specifying the values for field names
Field name

Value

Prompt

Root of example folder tree

Type

String

Help Text

Point to the root of the file tree folder

Each example uses this job parameter.
6. Create a link from each Sequential File stage to the XML stage.
7. Rename the stages and links as shown in the following table:
Table 28. Names for job elements
Element

Name

Sequential File stage

Address_File

Sequential File stage

Employee_File

Link from Address_File to XML

Address

Link from Employee_File to XML

Employee

8. Configure the Employee_File stage. Double-click the Employee_File stage to
open the stage properties. On the Properties tab of the Output page, configure
the following properties:
Table 29. Configuring the properties
Field name

Value

File

Enter the path and file name of the file. For
the Employee_File stage, the file name is
employee.txt.

Read Method

Select Specific File(s).
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Table 29. Configuring the properties (continued)
Field name

Value

First Line is Column Names

Select True.

9. Click the Columns tab, and create these columns:
Table 30. Columns for the Employee_File stage
Column name

SQL type

Length

LastName

VarChar

40

MiddleName

VarChar

40

FirstName

VarChar

40

Gender

VarChar

BirthDate

Date

Title

VarChar

HireDate

Date

EmployeeID

VarChar

DepartmentID

VarChar

10. Configure the Address_File stage. Double-click the Address_File stage to open
the stage properties. On the Properties tab of the Output page, configure the
following properties:
Table 31. Configuring the properties
Field name

Value

File

Enter the path and file name of the file. For
the Address_File stage, the file name is
address.txt.

Read Method

Select Specific File(s).

First Line is Column Names

Select True.

11. Click the Columns tab, and create these columns:
Table 32. Columns for the Address_File stage
Column name

SQL type

Street

VarChar

City

VarChar

State

VarChar

Country

VarChar

PostalCode

VarChar

Address_Type

VarChar

EmployeeID

VarChar

12. Choose File > Save , and name the job xml_hjoin_example.

Example 3: Creating the assembly
Use the HJoin step to create a parent-child hierarchy from a two lists; then use the
XML Composer step to compose the XML file.
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Before you begin
Make sure that you already imported the example schemas Employee.xsd and
Organization.xsd. If you have already built Example 1 or Example 2, you have
imported the schemas as part of that example. For more information about
importing the schemas, see Importing the schemas for the examples.

Procedure
1. Double-click the XML stage to open the stage properties, and then click Edit
assembly to open the Assembly Editor.
2. Open the Palette, and then double-click the HJoin step to add it to the
assembly.
3. Select the HJoin step, and then from the palette, double-click the
XML_Composer step to add it below the HJoin step.
4. On the Overview, in the Description field, enter the following description: This
assembly uses the Organization.xsd and Employee.xsd schemas. The HJoin
step creates a hierarchical structure, where the employee information is
the parent and the employee address information is the child. The
XML_Composer step composes the data and saves the output in a file named
employee_output.
5. This assembly uses the default Input step, which shows the columns that the
two input links, Employee and Address, pass to the XML stage. You cannot
modify the input columns, but you can display them as either links or a tree.
The following figure shows the structure that the Input step provides as step
Input to the Hjoin step. The two lists are at the same level in the hierarchy.

Example 3: Configuring the HJoin step
Use the HJoin step to create a parent-child hierarchy from a single list.

About this task
The step Input to the HJoin step contains two lists, Employee and Address. When
you configure the HJoin step, you identify which list is the parent list and which
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list is the child list, and you specify the keys to use to join the two lists together.
Wherever the value of the key item is the same in both lists, the HJoin step joins
the lists.

Procedure
1. On the Configuration tab of the HJoin step, configure these fields:
Table 33. Configuring the fields
Field name

Value

Parent List

Select top/InputLinks/Employee.

Child List

Select top/InputLinks/Address.

2. In the Optimization Type field, choose In-memory.
3. In the Parent Keys column, select top/InputLinks/Employee/EmployeeID.
4. In the Child Keys column, select top/InputLinks/Address/EmployeeID.

Results
The step Output shows the addition of the child list Address to the Employee list.
The step Output also contains a new node named HJoin:orphans, which contains
items that do not match the keys. The following figure shows this portion of the
step Output.

Example 3: Configuring the XML Composer step
Configure the XML Composer step to create a XML file that lists each employee
once, followed by the employee's two addresses.

Procedure
1. In the XML Target window of the XML Composer step, choose Write to File.
For the Output Directory, click Insert Parameter, and then select
xml_example_root_folder. For the Filename Prefix, enter employee_output.
2. In the Document Root window, select the schema element that describes the
documents that the step composes:
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a. Click Browse, and then open the Schemas_for_XML_examples library,
which is the library into which you imported the Organization.xsd and
Employee.xsd schemas.
b. Click to open the Employee.xsd schema, click the root element employees,
and then click OK. The Document Root tab displays the structure of the
schema.
3. On the Validation tab, select Minimal validation.
4. In the HJoin step, you combined two lists and established a hierarchical
structure where the address items are in a list that is a child of the employee
list. Now on the Mappings tab, map the items from the target schema to the
items in the Employee list. The target schema contains some items that you will
not use. For example, the target schema contains a list named Job, which
includes items such as jobTitle and startDate. You do not need mappings to
items in the Job list because the Regroup:Employees list does not contain any
job items. To create the mappings, perform the following steps:
a. The mapping for the document_collection item determines when a new
XML document is created. If you map the top element of the step Input to
document_collection, one document is created. If you map a list item to
document_collection, one document is created for each item in the list. The
name of each resulting file has the file name prefix that you specified on the
XML Target tab and an index that identifies the item that the output was
created from.
b. Map top/InputLinks/Employee in the Source list to the employee item in
the Target list, and then click Automap.
c. Using automatic mapping, you create the majority of the mappings that you
need, but you also create some mappings that you do not need. The Job list
item contains items that you do not need and that were automatically
mapped by choosing the best candidate for each item from the
top/InputLinks/Employees list. You need to clear these mappings because
you do not need them. Select the Job item in the Target list, and then click
Clear Mappings to clear all of the mapped child items.
d. Evaluate the rest of the mappings to confirm that they are what you want.
Notice that ns0:dateOfBirth in the Target list is mapped to
top/InputLinks/Employee/Input:HireDate in the Source list. This mapping
is incorrect. Click the arrow on top/InputLinks/Employee/Input:HireDate,
and then select top/InputLinks/Employee/Input:BirthDate/
e. Make sure to map all the fields correctly and they are available in the
output. If you see the incorrect mapping in the Source column, click the
pencil icon in the Source list for that item, and then click More to display a
list of choices. Click and choose the appropriate field from the drop-down
list to map the item.
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Results
The following figure shows the results of the mappings:

The step Output contains a new node, named XML_Composer:result. This node
carries the path and file name for the output file during runtime.

Example 3: Viewing the output of the job
After you finish building the assembly, run the job and look at the output.

Procedure
1. From the Assembly Editor, click OK to return to the XML stage editor. Then
click OK to close the XML stage editor.
2. From the IBM InfoSphere DataStage and QualityStage Designer client, choose
File > Compile to compile the job.
3. Choose File > Run to run the job.
4. In the parameter window, for the first parameter, Root of example folder tree,
enter the path of the directory where you have unzipped your examples zip
file. For example, if you have downloaded and saved the examples zip file in
C:\Examples folder, enter this directory as the Value for the first parameter,
Root of example folder tree.
5. Open the employee_output.xml file to look at the results, which are shown
below. The resulting file contains a list of employees. For each employee, the
home and office addresses are shown. The type of address, home or office, is
identified by the address_type tag, which displays O for office address and H
for home address.
<?xml version="1.0" encoding="UTF-8"?>
<tns:employees xmlns:tns="Http://ibm.com/infosphere/xml/Employee">
<tns:employee employeeID="B6540" departmentID="A100">
<name>
<firstName>Cynthia</firstname>
<middleName>P</middlename>
<lastName>Donald</lastName>
</name>
<gender>female</gender>
<dateOfBirth>1987-01-17</dateOfBirth>
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<title>Miss</title>
<Address>
<street>San Felipe, Suite 2400</street>
<city>Houston</city>
<state>Texas</state>
<country>USA</country>
<postalCode>77057</postalCode>
<address_type>O</address_type>
</Address>
<Address>
<street>53rd West Street</street>
<city>Houston</city>
<state>Texas</state>
<country>USA</country>
<postalCode>77000</postalCode>
<address_type>H</address_type>
</Address>
<hireDate>2007-07-25</hireDate>
</tns:employee>
<tns:employee employeeID="B6540" departmentID="A100">
<name>
<firstName>Tania</firstname>
<middleName>G</middlename>
<lastName>William</lastName>
</name>
<gender>female</gender>
<dateOfBirth>1980-01-17</dateOfBirth>
<title>Miss</title>
<Address>
<street>5th South Street</street>
<city>Miami</city>
<state>Florida</state>
<country>USA</country>
<postalCode>32599</postalCode>
<address_type>O</address_type>
</Address>
<Address>
<street>54th South Street</street>
<city>Miami</city>
<state>Florida</state>
<country>USA</country>
<postalCode>32501</postalCode>
<address_type>H</address_type>
</Address>
<hireDate>2007-07-25</hireDate>
</tns:employee>
<tns:employee employeeID="A8990" departmentID="A100">
<name>
<firstName>Zen</firstname>
<middleName>P</middlename>
<lastName>Wright</lastName>
</name>
<gender>male</gender>
<dateOfBirth>1980-04-4</dateOfBirth>
<title>Mr</title>
<Address>
<street>2301 East Lamar Blvd</street>
<city>Arlington</city>
<state>Texas</state>
<country>USA</country>
<postalCode>78363</postalCode>
<address_type>O</address_type>
</Address>
<Address>
<street>2001 West Street</street>
<city>Arlington</city>
<state>Texas</state>
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<country>USA</country>
<postalCode>78300</postalCode>
<address_type>H</address_type>
</Address>
<hireDate>2008-07-11</hireDate>
</tns:employee>
</tns:employees>

Example 4: Using the XML Parser and Switch steps
Create a job that uses the External Source Stage, XML stage, and two sequential
files. The Switch step is used to filter the data.

About this task
This example uses the sample XML data files, employee1.xml and employee2.xml,
and the sample schemas, Employee.xsd and Organization.xsd, to illustrate how to
filter the data based on the predefined conditions. The employee1.xml and
employee2.xml files contain information about the employees in a department. In
this example, you use External Source stage to read the files. Then you use the
XML Parser step and the Switch step within the XML stage, where the Parser step
validates the XML files and the Switch step filters the files based on the predefined
conditions. The output files contain the employee information: last name, middle
name, first name, gender, birth date, title, hire date, employee ID and department
ID.
Note: In this example, the employee2.xml file is invalid. The employee2.xml file
contains the data for the element dateOfBirth as 17-01-1987. The default format for
the date is YYYY-MM-DD. As the data does not follow this format, it is invalid. In
the XML Parser step, in Validation tab, there is a rule called, Data type has an
illegal value which checks if the value specified for an element is valid. This rule
is used in this example to validate the data.
After you complete all the steps in the assembly, the Assembly Editor will look as
shown in the figure below:
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The completed example job, xml_switch_example.dsx, is also available. To look at
the completed example or use it as the starting point for expanding the example,
import it into IBM InfoSphere DataStage.
To create the example, complete these tasks:

Example 4: Creating the job
Create the Switch example job that includes one External Source stage, one XML
stage, and two Sequential File stages.

About this task
The following figure shows the job that you create for this Switch example. The job
includes one External Source stage named Employee_Files, one XML stage named
Employee_Filter, and two Sequential File stages, named Employee_Validfile and
Employee_Invalidfile. The External Source stage is linked to the XML stage by a
link named Employee, and the XML stage is linked to two sequential files,
Employee_Validfile and Employee_Invalidfile by a link named Valid_file and
Invalid_file respectively.
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Procedure
1. Start the IBM InfoSphere DataStage and QualityStage Designer client.
2. In the Repository pane, right-click the Jobs folder, and select New > Parallel
job.
3. Open the File section of the palette, and drag one External Source stage to the
canvas.
4. Open the Real Time section of the palette, and drag one XML stage to the
canvas. Position the XML stage to the right of External Source stage.
5. Open the File section of the palette, and drag two sequential file stages to the
canvas. Position the two sequential file stages to the right of the XML stage.
6. Create a link from the External Source stage to the XML stage, and create links
from the XML stage to the two sequential file stages.
7. Rename the stages and links as shown in the following table:
Table 34. Names for job elements
Element

Name

External Source stage

Employee_Files

XML stage

Employee_Filter

Link from External Source stage to XML
stage

Employee

First Sequential File Stage

Employee_Validfile

Second Sequential File Stage

Employee_Invalidfile

Link from XML stage to Employee_Validfile

Valid_file

Link from XML stage to
Employee_Invalidfile

InValid_file

8. Create job properties for the location of the example files:
a. Click the Job Properties
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icon on the toolbar.

b. On the Parameters tab, in the Parameter Name field, enter
xml_example_root_folder, and then specify the following values for the
first parameter.
Table 35. Specifying the values for field names
Field name

Value

Prompt

Root of example folder tree

Type

String

Help Text

Point to the root of the file tree folder

c. On the Parameters tab, in the Parameter Name field, enter file_location,
and then specify the following values for the second parameter.
Table 36. Specifying the values for field names
Field name

Value

Prompt

Location of XML files

Type

String

Default Value

ls <Enter_the_location_of_the_zip>/xml_examples/
switch_step/example1/input_files/*.xml

Help Text

The location of the input files.

d. Click OK.
9. Double-click the External Source stage to configure the stage properties.
10. Click the Properties tab, and select Source > Source Program. Enter the path
for the input files, in the Source Program field. You can use the parameter,
file_location to specify the location of the input files.
Note: The External Source stage returns the absolute location of the xml files.
For example, if your data files (employee1.xml and employee2.xml) are in the
C:\Test\ directory, the output of the External Source stage will be
C:\Test\employee1.xml and C:\Test\employee2.xml.
11. Click the Columns tab, and create these columns:
Table 37. Columns for the Employee_Files stage
Column name

SQL type

employee_file_list

VarChar

12. Click OK.
13. By looking at the input file, employee1.xml, which contains the XML data,
you determine which columns to create to hold the employee data that the
XML stage will pass to the Employee_Validfile stage and the
Employee_Invalidfile stage.
14. Double-click the Employee_Validfile stage to configure the stage properties.
15. Click the Properties tab, and configure the following properties that define the
output file:
Table 38. Configuring the properties
Field name

Value

Target > File

Enter the path to where you want the
output file to be created, followed by the file
name for example, valid_emp.txt.
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Table 38. Configuring the properties (continued)
Field name

Value

Target > File Update Mode

Choose Overwrite to create the file.

First line is column name

Set to True.

16. Click the Columns tab, and create these columns:
Table 39. Columns for the Employee_Validfile stage
Column name

SQL type

Length

LastName

VarChar

40

MiddleName

VarChar

40

FirstName

VarChar

40

Gender

VarChar

BirthDate

VarChar

Title

VarChar

HireDate

Date

EmployeeID

VarChar

DepartmentID

VarChar

17. Click OK to close the Employee_Validfile stage.
18. Double-click the Employee_Invalidfile stage to configure the stage properties.
19. Click the Properties tab, and configure the following properties that define the
output file:
Table 40. Configuring the properties
Field name

Value

Target > File

Enter the path to where you want the
output file to be created, followed by the file
name for example, InValid_emp.txt.

Target > File Update Mode

Choose Overwrite to create the file.

First line is column name

Set to True.

20. Click the Columns tab, and create these columns:
Table 41. Columns for the Employee_Invalidfile stage
Column name

SQL type

Length

LastName

VarChar

40

MiddleName

VarChar

40

FirstName

VarChar

40

Gender

VarChar

BirthDate

VarChar

Title

VarChar

HireDate

Date

EmployeeID

VarChar

DepartmentID

VarChar

21. Click OK to close the Employee_Invalidfile stage.
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22. Choose File > Save , and name the job as xml_switch_example.

Example 4: Creating the assembly
Use the XML Parser stage to parse the XML files, the Switch step to separate input
files into valid and invalid files, and the Output step to map the data to the
sequential files.

Before you begin
Import the example schemas employee.xsd and organization.xsd. If you have
already built any of the previous examples, you have imported the schemas as part
of that example. For more information about importing the schemas, see Importing
the schemas for the examples.

Procedure
1. Double-click the XML stage to open the stage properties.
2. Click the Edit assembly to open the Assembly Editor.
3. Open the Palette, and then double-click the XML_Parser Step to add it to the
Assembly Outline.
4. Select the XML_Parser Step, and then from the palette, double-click the Switch
Step to add it below the XML_Parser Step in the Assembly Outline.
5. On the Overview, in the Description field, enter the following description: This
assembly uses the Organization.xsd and Employee.xsd schemas. The
XML_Parser Step reads xml files, the Switch Step filters the files, and
the Output Step maps the files into two sequential files.

Example 4: Configuring the XML Parser step
Configure the location of the XML source data and the schema that you want to
use.

Procedure
1. Click the XML Parser step in the Assembly Outline. By default, the
Configuration tab for the step opens. The following figure shows the
Configuration tab for the step:

2. On the XML Source tab, specify the location of the XML source data. In this
example, the XML source data is in multiple files, employee1.xml and
employee2.xml. Select File set, and choose the value from the list. The value is
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top/InputLinks/Employee/employee_file_list where employee_file_list is the
column specified in the External Source stage.
3. On the Document Root tab, select the schema element that describes the
documents that the step parses.
a. Click Browse, and then open the Schemas_for_XML_examples library,
which is the library into which you imported the Organization.xsd and
Employee.xsd schemas.
b. Click to open the Employee.xsd schema, click the root element employees,
and then click OK. The Document Root tab displays the structure of the
schema. The step Output also displays this same structure.
4. On the Validation tab, select Strict Validation. By selecting Strict Validation,
you automatically ensure that the data types conversion is performed. If you
use the default Minimal Validation, all data types are automatically set to the
String type.
5. In Value Validation, set the Data type has an illegal value rule to 'Reject'.
When you select the action as 'Reject', the Output schema displays two
elements named success and message in XML_Parser: ParserStatus. If the XML
file is valid, the 'success' will hold the parsing status as 'True' and if the XML
file is invalid, it holds the value 'False'. The 'message' will hold the reason for
the parsing failure if the 'success' is 'False'. The Data type has an illegal value
rule checks if the values specified for each of the elements in the XML file is
valid and within the specified range for that data type.
Note: In this example, the employee2.xml file is invalid. The employee2.xml
file contains the data for the element dateOfBirth as 17-01-1987. The default
format for the date is YYYY-MM-DD. As the data does not follow this format, it
is invalid and the 'success' will hold the value 'False'.
The following figure shows the Output Schema of the Parser step:
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Example 4: Configuring the Switch step
Use the Switch step to separate the input files into valid and invalid files.

XML transformation

79

About this task
With the Switch step you classify elements from the input files and place them into
new target lists. Each target list is associated with the criteria that you specify. You
can use multiple criteria in the target list. The data that passes the criteria is placed
in the corresponding target list and the default list will contain the data that fails
all the other criteria.

Procedure
1. On the Configuration tab of the Switch step, configure these fields:
Table 42. Configuring the fields
Field name

Value

List to Categorize

Select top/InputLinks/Employee. This is the list
that contains the items on which you specify the
criteria.

Scope

Choose top.

2. Select Add Target. In the New Target Constraint window, configure these fields:
v Specify the Target Name. In this example you specify the name as valid_file.
v Select the element in the Filter Field as 'success'.
v Select the function as 'IsTrue'.

Results
The Output step contains a new node named Switch:filtered, which contains two
lists. The valid data is placed in the valid_file list and the invalid data is placed in
the default list. The following figure shows this portion of the step Output.
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Example 4: Configuring the Output step
In the Output step, create mappings that define how to map source items in one
data structure to target items in another data structure.

About this task
In this assembly, you use the Output step to map a hierarchical data structure to a
relational data structure.

Procedure
1. Click the Output Step in the Assembly Outline to open the step. The step
displays the Configuration tab in the Output Step window. In the Output
window, the output table describes the data structure that is the output of the
assembly. The following figure shows the relevant columns of the output table
for this assembly:

The default view in the Output window is the Links view. The Links view
looks similar to the table that displays on the Columns tab in the XML stage
editor. The output structure for Valid_file link is shown above. In the Links
view, you can modify the columns that you already defined. Any changes that
you make to the columns are propagated to the column definitions in the
Sequential file.
2. From the Output Links drop-down list, select Invalid_file. The output structure
for Invalid_file link is shown below.
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3. Click the Mappings tab. The following figure shows the mapping table. In this
table, each item in the output structure is represented by a row in the table.
You map target items to source items. For this job, the target structure has two
links, Valid_file and Invalid_file, and the columns that are defined on those
links. In the Target column, the Valid_file and Invalid_file links are represented
as a list item and each column displays as a content item.
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4. To create mappings, first map target list items to source list items. Then map
target content items to source content items. Select the Valid_file list item in the
Target list and then in the Source select from the drop-down list,
top/Switch:filtered/valid_file/XML_Parser:result/tns:employees/employee
and click Auto Map.
The following figure shows the results of the automatic mapping for the
Valid_file.
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5. Next you need to map the Invalid_file list item. Select the Invalid_file list item
in the Target list and then in the Source select from the drop-down list,
top/Switch:filtered/default/XML_Parser:result/tns:employees/employee and
click Auto Map.
The following figure shows the results of the automatic mapping for the
Invalid_file.

When you map the Source items from the Suggestion list, you see only the
relative path. To view the entire path you can hover over each element.
6. Click OK to close the assembly editor.
7. Click OK to close the Stage Editor.
8. Save the job.

Example 4: Viewing the output of the job
After you run the switch job, open the text files, and look at the output.
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Procedure
1. From the IBM InfoSphere DataStage and QualityStage Designer client, choose
File > Compile to compile the job.
2. Choose File > Run to run the job.
3. In the parameter window, for the first parameter, Root of example folder tree,
enter the path of the directory where you have unzipped your examples zip
file. For example, if you have downloaded and saved the examples zip file in
C:\Test folder, enter this directory as the Value for the first parameter, Root of
example folder tree.
4. For the second parameter, after ls, change only the text within braces to specify
the path to the directory where you saved the example files. For example, if
you have placed the example files in C:\Test folder, specify ls
C:\Test\xml_examples\switch_step\example1\input_files\*.xml.
5. Click Run.
6. After the job runs, open the Valid_file.txt file and the Invalid_file.txt file
to look at the results.
The Valid_file.txt file contains this data:
"firstName","middleName","lastName","gender","dateOfBirth","title","hireDate",
"employeeID","departmentID"
"Zen","P","Wright","male","1980-04-04","Mr","2008-07-11","A8990","A100"

The Invalid_file.txt file contains this data:
"firstName","middleName","lastName","gender","dateOfBirth","title","hireDate",
"employeeID","departmentID"
"Cynthia","P","Donald","female","17-01-1987","Miss","2000-07-25","B6540","A100"

Example 5: Using the XML Parser and Union steps
Create a job that uses the XML stage and a Sequential file stage. The Union step is
used to combine two lists into a single list.

About this task
This example uses the sample XML data files, employee1.xml and employee2.xml,
and multiple sample schemas, to illustrate how to combine the two lists into a
single list that has a predefined structure. The employee1.xml and employee2.xml
files contain information about the employees in a department. In this example,
use the XML Parser steps within the XML stage to parse the files. Then you use the
Union step within the XML stage, to combine two lists into a single file. The XML
Composer step is used to compose a XML file that contains the employee
information. The output step maps the employee information to a single column in
the sequential file.
After you complete all the steps in the assembly, the Assembly Editor will look as
shown in the figure below:
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The completed example job, xml_union_example.dsx, is also available. To look at
the completed example or use it as the starting point for expanding the example,
import it into IBM InfoSphere DataStage.
To create the example, complete these tasks:

Example 5: Creating the job
Create the job that includes a XML stage, and a Sequential File stage.

About this task
The following figure shows the job that you create for the Union example. The job
includes a XML stage named Employees, and a Sequential File stage named
Employees_File. The XML stage is linked to a Sequential file stage by a link named
Employee_Union.
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Procedure
1. Start the IBM InfoSphere DataStage and QualityStage Designer client.
2. In the Repository pane, right-click the Jobs folder, and select New > Parallel
job.
3. Open the Real Time section of the palette, and drag XML stage to the canvas.
4. Create job properties for the location of the example files:
a. Choose the Edit > Job Properties.
b. On the Parameters tab, in the Parameter Name field, enter
xml_example_root_folder and then specify the following values:
Table 43. Specifying the values for field names
Field name

Value

Prompt

Root of example folder tree

Type

String

Help Text

Point to the root of the file tree folder

5. Open the File section of the palette, and drag a Sequential File stage to the
canvas. Position this stage to the right of the XML stage.
6. Create a link from the XML stage to the Sequential file stage.
7. Rename the stages and link as shown in the following table:
Table 44. Names for job elements
Element

Name

XML stage

Employees

Link from XML stage to Sequential File stage Employee_Union
Sequential File stage

Employees_File

8. Double-click the Employees_File stage to configure the stage properties.
9. Click the Properties tab, and configure the following properties that define the
output file:
Table 45. Configuring the properties
Field name

Value

Target > File

Enter the path where you want the output
file to be created, followed by the file name
employees_output.xml.

Target > File Update Mode

Choose Overwrite to create the file.

10. Click the Format tab. Right-click the field Quote = double, and select
Remove.
11. For the Employees_File stage, do not create any columns now. You will later
use the Assembly Editor to propagate the columns automatically.
12. Click OK to close the Employees_File stage.
13. Choose File > Save , and name the job as xml_union_example.

Example 5: Importing the schemas for the Union example
Use the Schema Library Manager to import the example schemas into the library.
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About this task
You must import the schemas that the example job uses. Imported schemas are
stored in the metadata repository, where they are available for use in any assembly
that you create.

Procedure
1. Double-click the XML stage to open the stage properties, and then click Edit
assembly to open the Assembly Editor.
2. From the Assembly Editor, click Libraries tab to open the Schema Library
Manager. You can either use Schema Library Manager from the Assembly
Editor or choose Import > Schema Library Manager from the IBM InfoSphere
DataStage and QualityStage Designer client.
3. To create a library for the example schemas, click New Library. In the New
Contract Library window, specify Schemas_for_XML_example for the library
name and Example for the category. The library is now categorized under
Example.
Note: If you have already built the previous examples, the library
Schemas_for_XML_example has been created and you need not perform the
step 3.
4. Similarly, create two more libraries, Schemas_for_XML_example1 and
Schemas_for_XML_example2 with the categories Example1, and Example2
respectively. The library is now categorized under Example1, and Example2.
5. Expand the category Example, select the library, Schemas_for_XML_example,
and then click Import New Resource. Browse to find the Employee.xsd schema.
Select the schema and then click OK. Repeat this process to import the
Organization.xsd schema. Similarly, import Employee1.xsd and
Organization1.xsd for the library, Schemas_for_XML_example1, and
Employee2.xsd and Organization2.xsd for the library,
Schemas_for_XML_example2.
The following schemas are located in the respective folders as shown:
Table 46. Schema location
Schema

Folder

Employee.xsd and Organization.xsd

xml_examples\schemas

Employee1.xsd, Organization1.xsd, and
Employee2.xsd, Organization2.xsd

xml_examples\union_step\example1\
union_schemas

6. If you have imported only one schema for example, Employee.xsd and have
not imported the other schema, Organization.xsd, then an error message is
displayed indicating that the library has failed validation. The error indicates
that the Employee.xsd schema cannot resolve the element JobType that has
been defined in the Organization.xsd schema, which you have not yet
imported. Repeat the import process to import the Organization.xsd schema.
The library passes the validation.
Similar issues might appear for the other schemas, Employee1.xsd,
Organization1.xsd, and Employee2.xsd, Organization2.xsd, if you have
imported only one schema among these.
Note: Multiple .xsd files can be imported at a time into the library. This can be
done by selecting multiple files in the browse window on clicking Import New
Resource.
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7. Click OK to close the Assembly Editor.
8. Click OK to close the Stage Editor.
9. Choose File > Save.

Example 5: Creating the assembly
In the assembly, you add the Parser, Union, and Composer steps where the Parser
parses the xml files, Union combines the files into a single file and the Composer
composes the XML file.

Before you begin
You have already imported the schemas in the previous step, Example 5: importing
the schemas for the Union example.

Procedure
1. Double-click the XML stage to open the stage properties, and then click Edit
assembly to open the Assembly Editor.
2. Open the Palette, and then double-click the XML_Parser Step to add it to the
Assembly Outline.
3. Select the XML_Parser Step, and then from the palette, double-click to add
another parser step below XML_Parser Step. This time it will be named as
XML_Parser_1 Step.
4. Select the XML_Parser_1 Step, and then from the palette, double-click the
Union Step to add it below the XML_Parser_1 Step.
5. Select the Union Step, and then from the palette, double-click the
XML_Composer Step to add it below the Union Step.
6. On the Overview, in the Description field, enter the following description: In
this assembly, the XML_Parser Step reads xml files, the Union Step
combines the two files, the Composer Step composes the xml file, and the
Output Step writes the xml file into a sequential file.

Example 5: Configuring the first XML Parser step
Configure the location and the schema of the first XML source data that you want
to parse.

Procedure
1. Click the XML_Parser step in the Assembly Outline. By default, the
Configuration tab for the step opens. The following figure shows the
Configuration tab for the step:
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2. On the XML Source tab, you specify the location of the XML source data. In
this example, the XML source data is in a single file, employee1.xml. Select
Single file and then click Insert Parameter, and select the
xml_example_root_folder parameter. You need to specify the exact location of
the file when you run the job. Enter the complete location of the XML input file
as, #xml_example_root_folder#/xml_examples/union_step/example1/
input_files/employee1.xml.
3. On the Document Root tab, you select the schema element that describes the
documents that the step parses. Click Browse. Open the
Schemas_for_XML_example1 library, which is the library into which you have
imported the Organization1.xsd and Employee1.xsd schemas.
4. Click to open the Employee1.xsd schema, click the root element Employee_List,
and then click OK. The Document Root tab displays the structure of the
schema. The step Output also displays this same structure.
5. On the Validation tab, select Strict Validation. By selecting Strict Validation,
you automatically ensure that the data types conversion is performed. If you
use the default Minimal Validation, all data types are automatically converted
to the String type.
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Example 5: Configuring the second XML Parser step
Configure the location and the schema of the second XML source data that you
want to parse.

Procedure
1. Click the XML_Parser_1 Step in the Assembly Outline. By default, the
Configuration tab for the step opens. The following figure shows the
Configuration tab for the step:

2. On the XML Source tab, you specify the location of the XML source data. In
this example, the XML source data is in a single file, employee2.xml. Select
Single file and then click Insert Parameter, and select the
xml_example_root_folder parameter. You need to specify the exact location of
the file when you run the job. Enter the complete location of the XML input file
as, #xml_example_root_folder#/xml_examples/union_step/example1/
input_files/employee2.xml.
3. On the Document Root tab, you select the schema element that describes the
documents that the step parses. Click Browse. Open the
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Schemas_for_XML_example2 library, which is the library into which you have
imported the Organization2.xsd and Employee2.xsd schemas.
4. Click to open the Employee2.xsd schema, click the root element
Dep_Employees_List, and then click OK. The Document Root tab displays the
structure of the schema. The step Output also displays this same structure.
5. On the Validation tab, select Strict Validation. By selecting Strict Validation,
you automatically ensure that the data types conversion is performed. If you
use the default Minimal Validation, all data types are automatically set the
String type.

Example 5: Configuring the Union step
Use the Union step to combine two lists to create a single list.

About this task
In the Union step you select the target schema definition from the Contract
Libraries and then map the target schema to the source schema in the mapping
table.

Procedure
1. On the Configuration tab of the Union step, configure these fields:
v Union Type – Click Browse to open the library, Schema_for_XML_example.
v Expand Employee, and select the root element, employee.
v Click OK.
The Union Type tab displays the structure of the employee schema.
2. Click the Mappings tab.
3. To create mappings, first map target list items to source list items.
4. On the Source, corresponding to the left list, click to choose EmployeeInfo from
the Suggestions list or drop-down list.
5. Click Auto Map. The Employee and Address information is mapped for the left
list. The following figure shows the result of Auto Map for the left list. The
target left list item and all of its child items are automatically mapped to source
items.
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6. You will see that the target item, dateOfBirth is wrongly mapped to the source
item, hireDate. You need to update this entry to create the correct mapping.
Click hireDate in the Source list to choose the correct item from the drop-down
list. The items in the list appear in order, from highest to lowest, based on their
mapping scores. Select DOB as the right candidate for the target item,
dateOfBirth from the drop-down list.
7. You will also see that the address fields are not mapped correctly in the Source
column. Make sure to map all the fields correctly and they are available in the
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output. If you see the incorrect mapping in the Source column, click the pencil
icon in the Source list for that item, and then click More to display a list of
choices. Click and choose the appropriate field from the drop-down list to map
the item. Following table shows the target items and the corresponding source
items that you need to manually map to:
Table 47. Corresponding source items to the target items
Source items

Target items

street_name

street

city_name

city

state_name

state

country_name

country

8. On the Source, corresponding to the right list, click to choose Dept_Employee
from the Suggestions list or drop-down list.
9. Click Auto Map. The Employee and Address information is mapped for the
right list.
As seen above, you can map two different schema structures to a common
schema structure in the Union step. The common schema structure is the one
that you define in the Union Type tab. In the Mappings tab, the left and right
lists have this common structure and you can map each of these lists to
different schema structures in the Source view. In this example, two different
schema structures are used in the parser. In the first parser, the EmployeeInfo
list contains the employee information and in the second parser,
Dept_employee list also contains the employee information. You can map the
EmployeeInfo list to the left list and Dept_employee list to the right list in the
Mappings tab. The following figure shows this view.
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Results
The step output contains a new node named Union:result. The structure of the
Union:result is same as the structure that is defined in the Union Type. The
following figure shows this portion of the step output.

Example 5: Configuring the XML Composer step
Configure the XML Composer step to create a XML file of the employees in a
department.
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Procedure
1. In the XML Target window of the XML Composer step, choose Pass as String.
This passes the composed XML string to a downstream step or stage for further
processing.
2. In the Document Root window, select the schema element that describes the
documents that the step composes:
a. Click Browse, and then open the Schemas_for_XML_examples library,
which is the library into which you imported the Organization.xsd and
Employee.xsd schemas.
b. Click to open the Employee.xsd schema, click the root element employees,
and then click OK. The Document Root tab displays the structure of the
schema.
3. On the Validation tab, by default Strict validation is selected. You need not
make any changes to the fields in this tab.
4. In the Union step, you combined two lists into a single hierarchical list. Now in
the Composer step, on the Mappings tab, map the items from the target
schema to the items in the Union:result list. To create the mappings, perform
the following steps:
a. Map top/Union:result in the Source list to the employee item in the Target
list, and then click Automap.
b. Using automatic mapping, you map each item from the Union:result list to
the employee list.
c. Evaluate all the items to see if the correct mapping is done. It is seen that
the mapping is done correctly.
5. On the Format tab, default encoding is UTF-8. You need not change this field.
6. Select the Format Style and configure the following fields.
a. In the Indentation length field, select the number of characters to use for
each indentation level in the XML output.
b. In the New Line Style field, select the type of new line. Choices are UNIX
(LF), DOS(CRLF) or MAC(CR).

Results
The step Output contains a new node, named XML_Composer:result. This node
carries the entire hierarchical data during runtime. The following figure shows the
output of the XML Composer step.

Example 5: Configuring the Output step
In the Output step, you create the mappings that define how to map target items
in one data structure to source items in another data structure.

About this task
In this assembly, you use the Output step to map the output of the composer to a
sequential file.
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Procedure
1. Click the Output Step in the Assembly Outline to open the step. The step
displays the Configuration tab in the Output Step window.

The default view in the Output window is the Links view. The output structure
for Employee_Union link is shown. The above figure shows that the output
table does not display any columns because when you created the job, you did
not define any columns for the Employee_Union link. The lack of columns is
not an error. However, if no columns are defined on the link, you cannot map
any source items in the hierarchical data structure to this link.
The composer output, result-string is a single column that contains the
employee data and you need to create that single column in this step. But
instead of returning to the job and manually creating the column, you can
automatically create it from the Mappings tab of the Output step.
2. Click the Mappings tab. The following figure shows the mapping table. In this
table, each item in the output structure is represented by a row in the table.
You map target items to source items. For this job, the target structure has a
single link, Employee_Union, and no columns are defined for this link. In the
Target column, the Employee_Union link is represented as a list item.

3. Next you need to map the Employee_Union list item. Select the
Employee_Union item. For this item, in the Source, select top from the
Suggestion list, and click Propagate. The Propagate automatically creates one
column for each item that is a descendent of the top item in the source
structure. When you use the Propagate button to create items, the items are
automatically mapped. The following figure shows the result.
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4. Click OK to close the assembly editor.
5. Click OK to close the Stage Editor.
6. Save the job.

Example 5: Viewing the output of the job
After you run the Union job, open the text file, and look at the output.

Procedure
1. From the IBM InfoSphere DataStage and QualityStage Designer client, choose
File > Compile to compile the job.
2. Choose File > Run to run the job.
3. In the parameter window, for the first parameter, Root of example folder tree,
enter the path of the directory where you have unzipped your examples zip
file. For example, if you have downloaded and saved the examples zip file in
directory, C:\Examples, enter this as the Value for the first parameter, Root of
example folder tree.
4. Click Run.
5. After the job runs, open the employees_output.xml file to look at the results.
The employees_output.xml file contains this data:
<?xml version="1.0" encoding="UTF-8"?><prn:employees
xmlns:prn="http://ibm.com/infosphere/xml/Employee">
<prn:employee employeeID="B6540" departmentID="A100">
<name>
<firstName>Cynthia</firstName>
<middleName>P</middleName>
<lastName>Donald</lastName>
</name>
<gender>female</gender>
<dateOfBirth>1987-01-17</dateOfBirth>
<title>Miss</title>
<Address>
<street>San Felipe Suite 2400</street>
<city>Houston</city>
<state>Texas</state>
<country>USA</country>
<postalCode>77057</postalCode>
<address_type>O</address_type>
</Address>
<Address>
<street>53rd West Street</street>
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<city>Houston</city>
<state>Texas</state>
<country>USA</country>
<postalCode>77000</postalCode>
<address_type>H</address_type>
</Address>
<hireDate>2000-07-25</hireDate>
</prn:employee>
<prn:employee employeeID="A8990" departmentID="A100">
<name>
<firstName>Zen</firstName>
<middleName>P</middleName>
<lastName>Wright</lastName>
</name>
<gender>male</gender>
<dateOfBirth>1980-04-04</dateOfBirth>
<title>Mr</title>
<Address>
<street>2301 East Lamar Blvd</street>
<city>Arlington</city>
<state>Texas</state>
<country>USA</country>
<postalCode>78363</postalCode>
<address_type>O</address_type>
</Address>
<Address>
<street>2001 West Street</street>
<city>Arlington</city>
<state>Texas</state>
<country>USA</country>
<postalCode>78300</postalCode>
<address_type>H</address_type>
</Address>
<hireDate>2008-07-11</hireDate>
</prn:employee>
</prn:employees>

Example 6: Using the XML Composer and H-Pivot steps
Create a job that uses a Sequential file stage and the XML stage. The H-Pivot step
is used to combine multiple fields into a single list.

About this task
This example is used to convert the relational file, address.txt into a XML file.
The address.txt contains address information of the employees in an organization.
Using the H-Pivot step you can map multiple fields into a single list. Use the XML
Composer step to create a hierarchical structure that contains employee address
information. The output step maps the address information to a single XML file.
The job includes one Sequential File stage, named Address_file, and a XML stage,
named Address_compose. The Sequential file stage is linked to a XML stage by a
link named Address.
After you complete all the steps in the assembly, the Assembly Editor will look as
shown in the figure below:
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The completed example job, xml_hpivot_example.dsx, is also available. To look at
the completed example or use it as the starting point for expanding the example,
import it into IBM InfoSphere DataStage.
To create the example, complete these tasks:

Example 6: Creating the job
Create the example job that includes one Sequential File stage and a XML stage.

About this task
The following figure shows the job that you create for the H-Pivot example. The
job includes one Sequential File stage named Address_file, and a XML stage named
Address_compose. The Sequential file stage is linked to a XML stage by a link
named Address.
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Procedure
1. Start the IBM InfoSphere DataStage and QualityStage Designer client.
2. In the Repository pane, right-click the Jobs folder, and select New > Parallel
job.
3. Open the File section of the palette, and drag a Sequential File stage to the
canvas.
4. Open the Real Time section of the palette, and drag XML stage to the canvas.
Position this stage to the right of the Sequential File stage.
5. Perform the following steps to create a job property for the location of the
example files:
a. Choose Edit > Job Properties.
b. On the Parameters tab, in the Parameter Name field, enter
xml_example_root_folder and then specify the following values:
Table 48. Specifying the values for field names
Field name

Value

Prompt

Root of example folder tree

Type

String

Help Text

Point to the root of the file tree folder

Each example uses this job parameter.
6. Create a link from the Sequential File stage to the XML stage.
7. Rename the stages and links as shown in the following table:
Table 49. Names for job elements
Element

Name

Sequential File stage

Address_file

XML stage

Address_compose

Link from Sequential File stage to XML stage Address

8. Create job properties for the location of the example files:
icon on the toolbar.
a. Click the Job Properties
b. On the Parameters tab, in the Parameter Name field, enter
xml_example_root_folder, and then specify the following values for the
first parameter.
Table 50. Specifying the values for field names
Field name

Value

Prompt

Root of example folder tree

Type

String

Help Text

Point to the root of the file tree folder

9. Click OK.
10. Configure the Address_file stage. Double-click the Address_file stage to open
the stage properties.
11. Click the Properties tab, and configure the following properties that define the
output file:
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Table 51. Configuring the properties
Field name

Value

Source > File

Enter the path and file name of the file. For
the Address_file stage, the file name is
address.txt

Source > Read Method

Select Specific File

Options > First Line is Column Names

Select True

12. Click the Columns tab, and create these columns:
Table 52. Columns for the Address_file stage
Column name

SQL type

street

VarChar

city

VarChar

state

VarChar

country

VarChar

postalCode

VarChar

phonenumber1

VarChar

phonenumber2

VarChar

address_type

VarChar

13. Click OK to close the stage properties.
14. Choose File > Save , and name the job as xml_hpivot_example.

Example 6: Creating the assembly
Use the H-Pivot step to combine multiple fields into a single list.

Before you begin
Make sure that you have already imported the example schemas Employee.xsd
and Organization.xsd. If you have built the XML Parser example, you have
imported the schemas as part of that example. For more information about
importing the schemas, see Importing the schemas for the examples.

Procedure
1. Double-click the XML stage to open the stage properties, and then click Edit
assembly to open the Assembly Editor.
2. Open the Palette, and then double-click the H-Pivot Step to add it to the
Assembly Outline.
3. Select the H-Pivot Step, and then from the palette, double-click the
XML_Composer step to add it below the H-Pivot step
4. On the Overview, in the Description field, enter the following description: This
assembly uses the Organization.xsd and Employee.xsd schemas. In the
H-Pivot step you combine multiple fields into a list. The XML_Composer
step composes the data and saves the output in a file named
address_output.

Example 6: Configuring the H-Pivot step
Use the H-Pivot step to transform fields or items into a list.
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About this task
With the H-Pivot step you combine multiple fields into a list. This helps in
mapping multiple fields into a single list in the composer.

Procedure
1. On the Configuration tab of the H-Pivot step, configure the field:
Table 53. Configuring the field
Field name

Value

Scope

Choose Address.

Note: The list that you select as the Scope contains the fields that need to be
transformed into a list.
2. Click and select the field, phonenumber1 from the drop-down list.
3. Click and select the field, phonenumber2 again from the drop-down list.

Results
The following figure shows the output of the H-pivot on the Output tab.

The output of the H-Pivot contains the list named rows. The rows include two
fields, name and value. The name represents the name of the field that you have
defined in the H-Pivot and the value holds the data for the corresponding names.
In this example, the field name contains phonenumber1 and phonenumber2, and
the field value contains the data related to the name.

Example 6: Configuring the XML Composer step
Configure the XML Composer step to create a XML file containing address
information.

Procedure
1. In the XML Target window of the XML Composer step, choose Write to File.
For the Output Directory, click Insert Parameter, and then select
xml_example_root_folder. For the Filename Prefix, enter address_output.
2. In the Document Root window, select the schema element that describes the
documents that the step composes:
a. Click Browse, and then open the Schemas_for_XML_examples library,
which is the library into which you imported the Organization.xsd and
Employee.xsd schemas.
b. Click to open the Employee.xsd schema, click the root element addresses,
and then click OK. The Document Root tab displays the structure of the
schema.
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3. On the Validation tab, by default Strict validation is selected. You need not
make any changes to the fields in this tab.
4. On the Mappings tab, map the items from the target schema to the items in the
address list. To create the mappings, perform the following steps:
a. Map top/InputLinks/Address in the Source list to the address item in the
Target list, and then click Automap.
b. Using automatic mapping, you create the majority of the mappings that you
need, but you also create some mappings that you do not need. For
example, the name is mapped to e2res:text(), which is not a correct mapping
and you need to change this to value.
c. The following figure shows the mapping.

5. Notice that the H-Pivot:result/rows is mapped to the list, phoneNumber. In
H-Pivot step, you have combined the fields, phonenumber1 and phonenumber2
into a single list, rows and the data is stored in the field, value. Hence the
H-pivot step allows you to map two relational fields in the input to a single list
in the composer.
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Results
The following figure shows the results of the mapping:

Example 6: Viewing the output of the job
After you finish building the assembly, run the job and look at the output.

Procedure
1. From the IBM InfoSphere DataStage and QualityStage Designer client, choose
File > Compile to compile the job.
2. Choose File > Run to run the job.
3. In the parameter window, for the first parameter, Root of example folder tree,
enter the path of the directory where you have unzipped your examples zip
file. For example, if you have downloaded and saved the examples zip file in
the directory, C:\Examples, enter this as the Value for the first parameter, Root
of example folder tree.
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4. Click Run.
5. After the job runs, open the address_output.xml file to look at the results. The
address_output.xml file contains this data:
<?xml version="1.0" encoding="UTF-8"?>
<tns:addresses xmlns:tns="http://ibm.com/infosphere/xml/Employee">
<tns:address>
<street>2301 East Lamar Blvd</street>
<city>Arlington</city>
<state>Texas</state>
<country>USA</country>
<postalCode>78363</postalCode>
<phoneNumber>1-234-234-4567</phoneNumber>
<phoneNumber>1-234-234-4566</phoneNumber>
<address_type>O</address_type>
</tns:address>
<tns:address>
<street>2001 West Street</street>
<city>Arlington</city>
<state>Texas</state>
<country>USA</country>
<postalCode>78300</postalCode>
<phoneNumber>1-876-456-4321</phoneNumber>
<phoneNumber>1-876-456-4320</phoneNumber>
<address_type>H</address_type>
</tns:address>
<tns:address>
<street>San Felipe Suite 2400</street>
<city>Houston</city>
<state>Texas</state>
<country>USA</country>
<postalCode>77057</postalCode>
<phoneNumber>1-965-234-1234</phoneNumber>
<phoneNumber>1-965-234-1235</phoneNumber>
<address_type>O</address_type>
</tns:address>
<tns:address>
<street>53rd West Street</street>
<city>Houston</city>
<state>Texas</state>
<country>USA</country>
<postalCode>77000</postalCode>
<phoneNumber>1-000-000-8765</phoneNumber>
<phoneNumber>1-000-000-8764</phoneNumber>
<address_type>H</address_type>
</tns:address>
<tns:address>
<street>5th South Street</street>
<city>Miami</city>
<state>Florida</state>
<country>USA</country>
<postalCode>32500</postalCode>
<phoneNumber>1-999-999-0989</phoneNumber>
<phoneNumber>1-999-999-0979</phoneNumber>
<address_type>O</address_type>
</tns:address>
<tns:address>
<street>54th South Street</street>
<city>Miami</city>
<state>Florida</state>
<country>USA</country>
<postalCode>32501</postalCode>
<phoneNumber>1-567-654-7890</phoneNumber>
<phoneNumber>1-567-654-7891</phoneNumber>
<address_type>H</address_type>
</tns:address>
</tns:addresses>
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Reference
These topics describe supported XML types and XML-type-to-DataStage-type
mappings, describe how to get the example files, and provide user responses to
error messages and information about working with IBM Software Support.
For more information on XML stage, refer to the Developer article links below:

Supported XML types and type mappings
When you create an assembly, refer to these tables that describe supported XML
types, DataStage-to-XML type mappings, and XML-to-DataStage type mappings.

XML types
This table describes the types that the XML stage supports and provides examples
of each type.
Table 54. Supported XML types
XML type

Examples

Duration

P0Y0M0DT0H0M0S
-P120D, P1Y2MT2S

dateTime

1970-01-01T00:00:00
1970-01-01T00:00:002001-04-29T14:29:03.5
2001-04-29T14:29:03+06:00
2001-04-29T14:29:03-06:00
20001-04-29T14:29:00Z

Time

00:00:00
14:29:03.5
14:29:03+06:00
14:39:03-06:00
14:29:00Z

date

1970-01-01
2001-04-29
-0099-04-29+06:00
2001-04-29-06:00
2001-04-29-06Z

gYear

1970
2065-05:00
-0099

gYearMonth

1989-01
2065-10-05:00
2065-07+05:00
2065-09Z

gMonth

--01
--10-05:00
--07+05:00
--09Z

gMonthDay

--01-29
--10-05:00
--01+07:00
--09Z

gDay--

--01

anyURI

http://sample.gov
../list.html#item
urn:sample.gov
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Table 54. Supported XML types (continued)
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XML type

Examples

ENTITY

namesNameWithNoColons

ENTITIES

namesNameWithNoColons1
namesNameWithNoColons2

ID

Unique_ID: aNameWithNoColons

IDREF

Reference_to_n_ID: aNameWithNoColons

IDREFS

namesNameWithNoColons1
namesNameWithNoColons2

QName

item
bag:item

token

A token has only single space character in
it.

language

en-US
fr

Name

foo3
foo:bar
non-leading.hyphen

NCName

aNameWithNoColons

NMTOKEN

comb .-:no_whitespace

NMTOKENS

comb_brush.-no_whitespace

NOTATION

item
bag:item

normalizedString

A normalizedString has only space
characters in it.

string

A string, which can include tab characters.

float

32-bit floating-point number. -34E5,
123.65E12, 98.72-2, 12, INF, -INF, NaN

double

64-bit floating-point number. -34E5,
123.65E12, 98.72-2, 12, INF, -INF, NaN

decimal

0, 0.0, +1134.56, -32.1

integer

-4, 0, 76768878778

long

Range is -9223372036854775808 to
9223372036854775807

int

Range is -2147483648 to 2147483647

short

Range is -32768 to 32767.

byte

Range is -128 to 127.

positiveInteger

Range is 1, 2, and so on.

nonPositiveInteger

Range is ..., -2, -1, 0.

negativeInteger

Range is ...-3, -2, -1.

nonNegativeInteger

Range is 0, 1, 2, and so on.

unsignedLong

Range is 0 to 18446744073709551615.

unsignedInt

Range is 0 to 4294967295.

unsignedShort

Range is 0 to 65535.

unsignedByte

Range is 0 to 225.
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Table 54. Supported XML types (continued)
XML type

Examples

hexBinary

None.

base64Binary

None.

boolean

Legal values are true and false; 1 and 0.

DataStage-to-XML type mappings
Table 55. DataStage-to-XML type mappings
DataStage type

XML type

BigInt

long

Unsigned BigInt

unsignedLong

Binary

binary

Bit

boolean

Char

string

Date

date

Decimal

decimal

Double

double

Float

double

Integer

int

Unsigned Integer

unsignedInt

LongNVarChar

string

LongVarBinary

binary

LongVarChar

string

NChar

string

Numeric

decimal

NVarChar

string

Real

float

SmallInt

short

Unsigned SmallInt

unsignedShort

Time

time

Timestamp

dateTime

TinyInt

byte

Unsigned TinyInt

unsignedByte

VarBinary

binary

VarChar

string

XML-to-DataStage data type mappings
This table shows the data type mappings.
Table 56. XML-type-to-DataStage data type mappings
XML type

DataStage data type

duration

VarChar

dateTime

TimeStamp
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Table 56. XML-type-to-DataStage data type mappings (continued)
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XML type

DataStage data type

time

Time

date

Date

gYear

Date

gYearMonth

Date

gMonth

Date

gMonthDay

Date

gDay

Date

anyURI

VarChar

ENTITY

VarChar

ENTITIES

VarChar

ID

VarChar

IDREF

VarChar

IDREFS

VarChar

QName

VarChar

token

VarChar

language

VarChar

Name

VarChar

NCName

VarChar

NMTOKEN

VarChar

NMTOKENS

VarChar

NOTATION

VarChar

normalizedString

VarChar

string

VarChar

float

Real

double

Double

decimal

Decimal

integer

Decimal

long

BigInt

int

Integer

short

SmallInt

byte

TinyInt

positiveInteger

Decimal

nonPositiveInteger

Decimal

negativeInteger

Decimal

nonNegativeInteger

Decimal

unsignedLong

Unsigned BigInt

unsignedInt

Unsigned Integer

unsignedShort

Unsigned SmallInt

unsignedByte

Unsigned TinyInt

hexBinary

VarChar
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Table 56. XML-type-to-DataStage data type mappings (continued)
XML type

DataStage data type

base64Binary

VarChar

boolean

Bit

Files for XML stage examples
The files includes schemas and data files that are used in the example jobs that
illustrate how to use steps to create assemblies for the XML stage.
You use these files when you create the example jobs that use the XML stage. For
each example, the finished job is available. You can either follow the step-by-step
instructions to build each example, or import the complete job and explore it on
your own.
To download the examples files, go to http://www.ibm.com/support/
docview.wss?uid=swg27019894.
Table 57. Example files
Example

Files

Example 1: Parsing XML data

departments.xml (input file), Employee.xsd
(schema), Organization.xsd (schema),
xml_parser_example.dsx (job), employee.txt
(output file), address.txt (output file)

Example 2: Using the XML Composer and
Regroup steps

departments.xml (input file), Employee.xsd
(schema), Organization.xsd (schema),
employee.txt (input file), address.txt (input
file), xml_composer_example.dsx (job),
employee_output.xml, (output file)

Example 3: Using the XML Composer and
HJoin steps

departments.xml (input file), Employee.xsd
(schema), Organization.xsd (schema),
employee.txt (input file), address.txt (input
file), xml_hjoin_example.dsx (job),
employee_output_xml (output file)

Example 4: using the XML Parser and
Switch steps

employee1.xml (input file), employee2.xml
(input file), Employee.xsd (schema),
Organization.xsd (schema),
xml_switch_example.dsx (job), valid_emp.txt
(output file), InValid_emp.txt (output file)

Example 5: using the XML Parser and Union employee1.xml (input file), employee2.xml
steps
(input file), Employee.xsd (schema),
Organization.xsd (schema), Employee1.xsd
(union_schemas\schema1),
Organization1.xsd (union_schemas\
schema1),Employee2.xsd
(union_schemas\schema2),
Organization2.xsd (union_schemas\
schema2),xml_union_example.dsx (job),
employees_output.xml (output file)

Messages
Identify an error or problem and resolve the problem by using the appropriate
recovery action.
XML transformation
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CDIUI2001I • CDIUI2216W
The following messages appear in the user interface at design time or in the job
log at run time. Messages have the following severity levels: Informational,
Warning, or Error. The last character in each message number indicates the
severity.

Design time messages (XML stage)
These messages might appear when you design a job that includes the XML stage.
CDIUI2001I {0} started. Input arguments follow: {1}
Explanation: This informational message is seen in the
log and indicates that the application has started.
User response: None.

CDIUI2202W This feature is not available in this
release.
Explanation: The feature that you are trying to use is
not available.
User response: None.

CDIUI2002I {0} closed.
Explanation: This informational message is seen in the
log and indicates that the application has ended.
User response: None.
CDIUI2003I Changed log level from {0} to {1}.
Explanation: This informational message occurs when
the logging level is changed in the application. The
logging “Level” can be changed in the Options dialog,
under the heading Logging"
User response: No action needed. This is an
informational message only.
CDIUI2004I Child list includes additional fields due
to changes you have made to the
assembly.
Explanation: A change to the upstream schema has
occurred. This change has resulted in additional fields
to the child list.
User response: This message is informational. No
resolution is required.

CDIUI2203W XSLT/Xquery document size must be
within memory limits.
Explanation: Warning that the XSLT/Xquery
document must fit within the memory limits defined
for this XML Stage.
User response: If required, update the XML Stage
properties to specify more memory.
CDIUI2206W Request to get assembly context
ignored, the assembly context id is not
yet set.
Explanation: An error has been detected that will
prevent the application from obtaining the assembly
editing session context. This situation detected indicates
the application is in the bring-up phase. It must be
completely operational to obtain this information. This
request could be due to a query by the user from the
Options dialog while the application is loading.
User response: Retry the operation when the
application is fully operational.

CDIUI2006I This randomly generated data, not
actual data, is used to test the assembly.

CDIUI2214W Call for service '{0}' ignored. The path
'{1}' associated with this service is no
longer valid. Existing mapping follows:
{2}.

Explanation: The informational message indicates that
test data, not input files, is used to test the assembly.

Explanation: A previous mapping is now incorrect,
possibly because of an upstream schema change.

User response: None needed.

User response: Correct the mapping or upstream
schema, and retry the operation.

CDIUI2201W Detected step mismatch for deletion.
Removing correct saved step: {0} with id
{1}. Ignoring this step {2} with id {3}.
Explanation: This message is a warning of a condition
that has been detected and corrected regarding
assembly step deletion.
User response: None.
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CDIUI2216W The requested action is in progress.
Wait until the request has completed
before attempting another action.
Explanation: An action was attempted that is invalid
because a prior action is still processing.
User response: Retry the action after the initial one
has completed.

CDIUI2218W • CDIUI2411E
CDIUI2218W Warning, you are about to exit this
application. You have made changes to
the assembly that are not saved.
Explanation: The user was asked to save changes
before exiting and responded "No." Any changes that
were made to the assembly are not saved.
User response: None necessary.

CDIUI2406E An internal error was detected during
the step removal process. Please try
again. Make sure the step for removal is
not the Overview, Input, or Output step.
Explanation: An attempt was made to remove a step,
such as the Input or Output step, which cannot be
removed.
User response: Do not attempt to remove this step.

CDIUI2401E Select an item, and then perform the
action.
User response: Some graphical trees in the application
require the selection of a tree node before performing
an action upon it.
User response: Use the left-mouse button to select the
node. Then attempt the action on the node.
CDIUI2402E Configuration mismatch detected.
Received step {0} from server that is not
defined in {1} property file. The step
will be ignored.
Explanation: This message occurs when a new step
type is only partially provisioned by a third party.
User response: Contact the system administrator to
ensure that all software updates to the server and UI
have been made.
CDIUI2403E Item {0} was selected for both lists.
Choose a different item for each list.
Explanation: For some steps, it is invalid to select the
same item for two lists.
User response: Choose a different item for one of the
lists and retry the operation.
CDIUI2404E Pairs of items must be unique. This pair
of items was selected twice: {0} and {1}.
Select a unique pair of items.
Explanation: An attempt was made to select the same
pair of items twice, such as a selection of the same
parent and child keys in an HJoin. This message
indicates that duplicate selections are not allowed.
User response: Specify a different pair of items for the
second selection and retry the operation.
CDIUI2405E This item was selected twice: {0}. Select
a different item for the second selection.
Explanation: An attempt was made to select the item
twice, such as a selection of the same key in a Regroup.
This message indicates that duplicate selections are not
allowed.

CDIUI2407E Download failed with error "{0}".
Explanation: Download of an item such as the
assembly context or the recording of the client-server
transactions failed. The error code shown in this
message provides an indication as to why this failure
occurred. A download failure typically means the
server is no longer available for downloads.
User response: Check that the server used by this
application is operational and accessible, and then retry
the operation.
CDIUI2408E Column names must be unique.
Explanation: A column name was entered that has
already been chosen.
User response: Retry the operation and specify name
that is unique.
CDIUI2409E Enter a name that begins with an
alphabetic character and contains only
alphanumeric characters, underscores,
dollar signs ($), and periods.
Explanation: A name was entered that is invalid.
User response: Retry the operation and specify a
name that contains only alphanumeric characters,
underscores, dollar signs ($), and periods.
CDIUI2410E Enter a name that begins with an
alphabetic character or an underscore.
Explanation: A name was entered that is invalid.
User response: Specify a name that begins with an
alphabetic character or an underscore.
CDIUI2411E Another target with that name already
exists.
Explanation: A name was entered that is invalid.
User response: Retry the operation and specify a
name that is unique.

User response: Specify a different item for the second
selection and retry the operation.
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CDIUI2412E • CDIUI2504E
CDIUI2412E The '{1}' version of the Adobe Flash
Player ActiveX control is not supported.
Install a supported version.
Explanation: The application detected an out-of-date
version of Adobe Flash Player.
User response: Install the required version of the
Flash Player from Adobe.
CDIUI2413E An associated editor was not specified
or cannot be found for this step.
CDIUI2414E One or more fields are no longer valid.
Explanation: A field has an invalid value.
User response: Change the value in this field to be
valid, or delete the field if applicable.
CDIUI2415E The addition of step type "{0}" failed.
You cannot add a step when one is still
loading.
Explanation: If a step is added while another step is
still loading, this error occurs.
User response: Allow the step to complete loading
before adding a new step.
CDIUI2416E A valid mapping target was not selected.
Select a valid target item in the
mapping table, and then retry the
action.
Explanation: A mapping target is chosen by selection
of a row to map in the mapping table. A valid row was
not selected.
User response: Select a valid row in the mapping
table and retry the action.
CDIUI2417E There are no mappings for the selected
target item '{0}' because an upstream
step has errors. Correct the errors, and
then retry the action.
Explanation: An attempt to map a source item to a
target item was made, but no mappings suggestions
were found for the target item. The lack of mapping
suggestions is often caused by errors in an upstream
step in the assembly.
User response: Correct the errors in the previous
steps, and then retry the action.
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CDIUI2418E The source item '{0}' is not a valid
mapping choice for the target item '{1}'.
Possible causes: the mapping results in
an invalid type conversion; the source
item and target item do not have the
same dimension; or the source item is
not a child of the previously mapped
parent item.
Explanation: An invalid source item was selected for
the target item.
User response: Select a valid source item.
CDIUI2501I Either no Output data is available, or
you need to test the assembly before
Output data can be displayed.
Explanation: This message is seen if a step is testable,
but the test assembly action has not been performed.
User response: Click the Test Assembly button and
then click Run Test. When the test completes, close the
dialog, and retry this operation.
CDIUI2502E The step has errors. Therefore, you
cannot test it.
Explanation: This message appears on the Test tab of
a step if the step has errors. Only steps that have no
errors can be tested.
User response: Go to the Configuration tab of the
step, correct the step errors, and then retry the
operation.
CDIUI2503E The upstream step has errors; therefore,
no output data will be available when
running tests.
Explanation: This message displays on the Test tab of
a step when the step can be tested, but the preceding
step in the assembly has errors. The errors in the
preceding step prevent the current step from being
tested.
User response: Correct the errors in the preceding
step and then test the assembly.
CDIUI2504E There was a problem parsing the XML
input test data.
Explanation: The input XML test data must be valid
XML.
User response: Correct the input test data and retry
the operation.

CDIUI2601E • CDIUI2801E
CDIUI2601E An unrecoverable error has occurred.
Method '{0}' failure. Server {1} request
URI is: '{2}'. Error condition is '{3}'.
Client session ID is '{4}'. The application
must exit. For more information, see log
file '{5}'.
Explanation: This error occurs when an HTTP service
call from the UI to the server fails. It can indicate an
unexpected error condition; it can also indicate that the
server has become unavailable. This information
gathered in this message is for the IBM Software
Support team.
User response: Check that the server used by this
application is operational and accessible and retry the
operation when it becomes available. If the problem
persists, contact IBM Software Support. .

DataStage and QualityStage Designer can access the
server without error. Restart the assembly editor, and
retry the operation. If the problem persists contact IBM
Software Support.
CDIUI2606E A required item is not in the schema
because a previous step renamed or
deleted the item or its parent. Restore
the item, or change the mapping; then
retry the action. Server status code is
410.
Explanation: A required item is incorrect, possibly
because of an upstream schema change.
User response: Correct the upstream schema or
change the mapping and retry the operation.

CDIUI2603E The requested item was not found. It
has either been renamed or removed.
Either restore the item or refresh the
view and retry the action. Server status
code is 410.

CDIUI2607E The request timeout of {0} seconds
occurred before the server responded. It
is possible that the server was
processing other requests or that the
server is unavailable or unreachable.
Server URL: '{1}'.

Explanation: The item requested is not in the contract
library.

Explanation: The HTTP call placed by the UI did not
return before the timeout occurred.

User response: Check that all of the items are
imported in the library and that they are correct.
Re-import any items needed. Then retry the operation.

User response: If you have determined the server is
functioning and reachable, retry the action again.

CDIUI2604E Unable to display the requested service
operation details due to an XML parsing
error. The library must parse cleanly
before its service operations can be
displayed. Server status code is 409.
Explanation: A contract library cannot be opened
unless its components parse correctly.
User response: Correct the imported library
components. Ensure that they are all present and that
they parse correctly. Re-import any corrected items as
needed. Then retry the operation.
CDIUI2605E Unable to authenticate with server '{0}'.
Possible causes: the server is no longer
available or reachable; the credentials
are incorrect; the session expired; or the
session is no longer valid because the
server was restarted.
Explanation: This error occurs when a call for
authentication from the UI to the server fails. It can
indicate a session issue, such as the server has been
restarted and the session is no longer valid; it can also
indicate that the server has become unavailable. This
information gathered in this message is for IBM
Software Support.

CDIUI2608E The request timeout of {0} seconds
occurred before the server responded. It
is possible that the server is unavailable
or unreachable. Server URL: '{1}'.\nThe
application must exit.
Explanation: This error is seen when an HTTP service
call from the UI to the server has not returned before
the timeout occurred. It can indicate an unexpected
error condition; it can also indicate that the server has
become unavailable.
User response: Check the server used by this
application is operational and accessible and retry the
operation when it becomes available. If the problem
persists, contact the IBM Software Support.
CDIUI2801E This mapping is invalid. The target item
{2} has the data type {1} which cannot be
converted to data type {0}.
Explanation: This message is an error that is seen
while configuring a step in the assembly editor. It is
seen when a source mapping selection for a field
would cause a type cast that is not valid.
User response: Either change the field specified to one
of a similar type, or change the selection in the
mapping list to a field that has a compatible type to the
specified field.

User response: Check that the server used by this
application is operational and that the InfoSphere
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CDIUI2802E • CDIUI2813E
CDIUI2802E Item {1} is not valid for {0}. A prior step
modified the schema, either by
renaming or deleting the item.
Explanation: A required item is now incorrect,
possibly because of an upstream schema change.
User response: Correct the upstream schema, or
change the mapping and retry the operation.
CDIUI2803E The mapping of source item {1} to target
item {0} is not valid because a previous
step modified the schema, by either
renaming, deleting or modifying the
source item.

identified in the prior message. Otherwise, contact IBM
Software Support with the information contained in
this message.
CDIUI2808E Key {0} of type {1} is not compatible
with key {2} of type {3}.
Explanation: This message is an error that is seen
while configuring a step in the assembly editor. It
indicates the key types are incompatible.
User response: Select keys that have compatible types.
CDIUI2809E The type {1} of {0} is not a valid key
type.

Explanation: A required item is now incorrect,
possibly because of an upstream schema change that
occurred because of a mapping action.

Explanation: This message is an error that is seen
while configuring a step in the assembly editor. The
type of the selected field is not a valid type for a key.

User response: Correct the upstream schema, or
change the mapping and retry the operation.

User response: Select a key with a valid type.

CDIUI2804E The value {0} as input for {1} is not
valid.
Explanation: This message is an error that is seen
while configuring a step in the assembly editor. It is
seen when an invalid valid is detected.
User response: Correct the error indicated for this
step. Choose a different value for the input specified.
CDIUI2805E Input is required for: {0}.
User response: This message is an error that is seen
while configuring a step in the assembly editor. In
general, seen when performing a mapping such as in
the mapping table. It indicates that a mapping has not
been performed for the field specified.
User response: Perform a mapping for the field
specified.

CDIUI2810E There is no matching parent key
defined for {0}.
Explanation: This message is an error that is seen
while configuring a step in the assembly editor. A
parent key is required but not selected for the specified
field.
User response: Select a parent key.
CDIUI2811E There is no matching child key defined
for {0}.
Explanation: This message is an error that is seen
while configuring a step in the assembly editor. A child
key is required but not selected for the specified field.
User response: Select a child key.

CDIUI2806E The {0} expression is not valid: {1}.

CDIUI2812E The mapping of the constant value {0} to
the target item {2} is invalid because the
constant value cannot be converted to
data type {1}.

Explanation: This message is an error that is seen
while configuring a step in the assembly editor, such as
creating an expression in the Switch step. It is seen
when the specified expression is not valid.

Explanation: This message is an error that is seen
while configuring a step in the assembly editor. It is
seen when a constant mapping is specified that is
cannot be converted to the type for the target field.

User response: Correct the expression.

User response: Input a valid constant for the target
that is compatible for the specified type.

CDIUI2807E An internal error occurred {0}.
Explanation: This error indicates an internal error in
the server-side services.
User response: Examine the context surrounding this
error message in the log file. If other errors were
logged prior to this message, such as any error
indicating the server became unavailable, this message
could be due to that prior condition. Follow the actions
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CDIUI2813E Link {0} does not have a column.
Explanation: The input or output link in the job does
not have a column associated with it.
User response: Return to the stage editor and create
some columns for the links or create a column in the
Input or Output step.

CDIUI2814E • CDIUI2904W
CDIUI2814E The child list cannot be contained in the
parent list.
Explanation: You cannot select a child list that is
already contained in the parent list.
User response: Select a different child or change the
parent list.
CDIUI2815E The processing instructions are not
valid: {0}
Explanation: Invalid processing instructions have been
entered.
User response: Review the processing instructions and
verify that they are valid.
CDIUI2816E The mapping for target item {0} is not
valid because of a missing or invalid
ancestor list mapping {1}.
Explanation: The mapping of this item cannot be
performed until its parent is mapped.
User response: Map the parent item first, then retry
this action.
CDIUI2817W {0} ***CANCELLED*** queued step:
'{1}' selected step: '{2}' queue length: '{3}'
request URL: '{4}'.
Explanation: A request to the server has been canceled
because of a change to a step.
User response: It is possible that an assembly update
was not made because of this step change. Check the
old step to make sure all changes needed were
performed.
CDIUI2820E The mapping is not applicable due to an
invalid type conversion or difference in
the source and target list dimensions.
Explanation: The mapping attempted was invalid.
Either the source and target types are incompatible. Or
when the list dimensions between the source and target
are different, such as one versus a two dimensional list.
User response: Retry the mapping with a valid source
for the selected target.
CDIUI2821E This mapping requires a data type
conversion that might cause a runtime
error.
Explanation: The mapping of source and target items
may not be convertible at runtime.
User response: Map the source and target items with
items that can be converted at runtime.

CDIUI2822E This mapping requires a data type
conversion that might cause values to
lose precision.
Explanation: At runtime, this type mapping might
cause data precision to be lost.
User response: No action required if this loss is
acceptable; otherwise, change the mapping to types that
are compatible..
CDIUI2823E This mapping requires a data type
conversion.
Explanation: The source and target items are not of
the same type and a runtime conversion will occur.
User response: Unless this mapping is invalid, no
action is required.
CDIUI2824E The source data type cannot be
converted into the target data type.
Explanation: The source column data type cannot be
converted to the target type.
User response: Re-map a with a compatible type.
CDIUI2825E When mapping a target List, the source
node must be a List.
Explanation: This error occurs when you attempt to
map a non-list item to a list.
User response: Map only similar items.
CDIUI2826E When mapping a content Item
(Non-List), the source node must be a
content Item (Non-List).
Explanation: This error occurs when you attempt to
map a list item to a non-list item.
User response: Map only similar items.
CDIUI2903W Select a pair of keys; otherwise, the
step will calculate a Cartesian product.
Explanation: This message occurs when no keys have
been specified for a step such as the HJoin step.
User response: Select a pair of keys for the step.
CDIUI2904W Data loss is possible for the data type
conversion from type {0} to type {1} for
item {2}.
Explanation: This message occurs when a type
conversion might result in data loss – for example, a
conversion from a decimal number to an integer.
User response: If data loss is acceptable, ignore this
message; otherwise, choose an item that has a type that
will not result in a loss of data.
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CDIUI2905W • CDIUI4610E
CDIUI2905W A runtime data conversion error might
result in data loss when converting from
data type {0} to data type {1} for item {2}.
Explanation: This message occurs when a type
conversion might result in data loss – for example, a
conversion from a decimal number to an integer.
User response: If data loss is acceptable, then ignore
this message; otherwise, choose an item that has a type
that will not result in a loss of data.
CDIUI3001I Validation is not available until the
previous tabs are completed.
Explanation: The validation for this step is dependent
on the completion of prior actions in the step.
User response: Perform any prior actions to the
validation tab. Then retry the operation.
CDIUI4401E The specified file must have the file
extension *.xsd.
Explanation: The import operation in the “Libraries”
tab of the application detected an attempt to upload a
file that is not valid type. Only files of type XSD is
allowed.
User response: Retry the import, specifying a type of
file that is allowed.
CDIUI4402E The library failed validation because
one or more resources failed validation.
Explanation: The validation of a contract library
failed.
User response: Examine the detailed validation
messages and correct the errors indicated.
CDIUI4403E One or more resources failed validation.
Click Validate to view the errors.
Explanation: The validation of a contract library
failed.
User response: Examine the detailed validation
messages and correct the errors indicated.
CDIUI4605E Library names must be unique. Enter a
unique name.

CDIUI4606E Unable to display the library type list
due to an XML parsing error. The
library must parse cleanly before the
type list can be displayed. Server status
code is 409.
Explanation: Only libraries that are valid (parse) can
be opened. An attempt to open a library with errors to
view its contained type list was detected.
User response: Correct the library parse errors,
validate the library, then retry the operation.
CDIUI4607E Unable to display the requested type
schema due to an XML parsing error.
The library must parse cleanly before its
types can be displayed. Server status
code is 409.
Explanation: Only libraries that are valid (parse) can
be opened. An attempt was made to view a type
schema in a contract library.
Explanation: Correct the library parse errors, validate
the library, and then retry the operation.
CDIUI4608E Unable to display the library service list
due to an XML parsing error. The
library must parse cleanly before the
service list can be displayed. Server
status code is 409.
Explanation: Only libraries that are valid (parse) can
be opened. An attempt to open a library with errors to
view its contained services list was detected.
User response: Correct the library parse errors,
validate the library, and then retry the operation.
CDIUI4609E The requested item was not found. It
has either been renamed or removed.
Either restore the item or refresh the
view and retry the action. Server status
code is 410.
Explanation: Only libraries that are valid (that parse)
can be opened. An attempt was made to view a service
in a contract library.
User response: Correct the library parse errors,
validate the library then retry the operation.

Explanation: A library create failed because the library
with the specified name already exists.

CDIUI4610E A resource with the same file location
already exists.

User response: Specify a different name when creating
a new library.

Explanation: The operation attempted is invalid
because the resource already exists in the library.
User response: Specify a different resource and retry
the operation.
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CDIUI4611E • CDIUW2015E
CDIUI4611E The requested resource was not found
in the specified library.
Explanation: The operation attempted is invalid
because the resource requested is not on the library.
This could happen if the library is out of sync with the
resource view, possibly due to actions performed by
another user on the same library.

CDIUW2001I server = {0} userid = {1}
Explanation: Log message.
User response: This message is informational.
CDIUW2002E DataStage did not provide the XML
stage with a context.

User response: Refresh the view of the contract library
using the refresh icon and then select the library again
to view its resources.

Explanation: Launching the Assembly Editor from the
stage editor dialog, or launching the Schema Library
Manager from the Designer Import menu. This message
can also appear in the log.

CDIUI4612E Specify the file location of the resource.

User response: Contact IBM Software Support.

Explanation: An attempt to import a resource into the
contract library without specifying a file location was
made. A file location is required.

CDIUW2003E Error retrieving stage display name
from the context string.

User response: Retry the operation with a file
location.

Explanation: Launching the Assembly Editor from the
stage editor dialog box. This message can also appear
in the log.

CDIUI4613E Only resources that have the following
file types can be imported into the
library: WSDL, XSD, and ZIP.

User response: Internal error. Contact IBM Software
Support.

Explanation: Only resources of type WSDL, XSD or
ZIP are supported.

CDIUW2012E Error displaying dialog.

User response: Retry the operation on a resource type
that is supported.
CDIUI4614E The item you tried to access is in use,
locked, or has been changed by another
user. Retry later. Note: The view may
need to be refreshed.
Explanation: Another user is using this item.
User response: Wait and retry after the other user
closes the item.
CDIUI4615E The session with server '{0}' has expired.
Please restart the {1} application. Server
status code is 408.
Explanation: If there is no user interaction with the
assembly editor for too long a period, the assembly
editor session will time out.
User response: Restart the assembly editor.
CDIUW2001E Unable to load resources.
Explanation: This message might appear when you
click Edit assembly to start the Assembly Editor from
the stage editor or when you choose Import > Schema
Library Manager from the IBM InfoSphere DataStage
and QualityStage Designer. This message might also
appear in the log file.
User response: There is a problem locating the XML
client files. Re-install the XML stage.

Explanation: Log message.
User response: There was a problem launching the
Assembly Editor or the Schema Library Manager.
Check other log messages or errors reported by the UI
in a message box for more specific information about
the problem.
CDIUW2013W The log file has reached its maximum
size. No more messages will be logged.
Explanation: Log message.
User response: The maximum log file size can be
increased by modifying the
“xmlui.logging.maxLogFileSize” entry in the
“xmlui.properties” file. The default maximum log size
is 10,000,000 bytes.
CDIUW2014E Unable to return context to DataStage.
Explanation: Launching the Assembly Editor from the
stage editor dialog box. This message can also appear
in the log.
User response: Internal error. Contact IBM Software
Support.
CDIUW2015E Unable to read file {0}.
Explanation: Launching the Assembly Editor from the
stage editor dialog box, or launching the Schema
Library Manager from the Designer Import menu. This
message can also appear in the log.
User response: Check the specified file path to see
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CDIUW2018I • CDIUW2026E
whether the file exists and is accessible. Contact
support if the problem cannot be resolved.
CDIUW2018I ClientID is {0}.
Explanation: Log message.
User response: This message is informational.
CDIUW2020E Unable to create temporary file.
Explanation: Launching the Assembly Editor from the
stage editor dialog, or launching the Schema Library
Manager from the Designer Import menu. This message
can also appear in the log.
User response: Check temp file directory permissions
and available disk space. Contact support if the
problem cannot be resolved.
CDIUW2021E Unable to write file {0}.
Explanation: Launching the Assembly Editor from the
stage editor dialog, or launching the Schema Library
Manager from the Designer Import menu. This message
can also appear in the log.
User response: Check the specified file path to see
whether the target directory exists and is accessible.
Contact support if the problem cannot be resolved.
CDIUW2022E Unable to create log file in directory
{0}.
Explanation: Launching the Assembly Editor from the
stage editor dialog, or launching the Schema Library
Manager from the Designer Import menu.
User response: Check the specified directory path to
see whether the directory exists and is accessible.
Contact support if the problem cannot be resolved.
CDIUW2023E Unable to determine the log file
directory.
Explanation: Launching the Assembly Editor from the
stage editor dialog, or launching the Schema Library
Manager from the Designer Import menu.
User response: Internal error. Contact IBM Software
Support.
CDIUW2024E Unable to open {0}.
Explanation: Launching the Assembly Editor from the
stage editor dialog, or launching the Schema Library
Manager from the Designer Import menu.
User response: Internal error. Contact IBM Software
Support.
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CDIUW2025E The application server is unavailable
or not operational.
Explanation: Launching the Assembly Editor from the
stage editor dialog, or launching the Schema Library
Manager from the Import menu in the InfoSphere
DataStage and QualityStage Designer.
User response: Check the server used by this
application is operational and accessible and retry the
operation when it becomes available. If the problem
persists, contact IBM Software Support.
CDIUW2026E An unrecoverable error has occurred.
Server {0} request URI is: '{1}'. Error
condition is '{2}'. Client session ID is
'{3}'. The application must exit. For more
information, see log file '{4}'.
Explanation: Launching the Assembly Editor from the
stage editor dialog, or launching the Schema Library
Manager from the Designer Import menu.
User response: Check the server used by this
application is operational and accessible and retry the
operation when it becomes available. If the problem
persists, contact IBM Software Support.

CDIER0001E • CDIER0023E

Runtime messages (XML stage)
These messages might display when you run a job that includes the XML stage.
CDIER0001E The XML namespace was not defined in
the schema, name={1}, line number={2},
column number={3}.
CDIER0002E The XML element was not defined in
the schema, name={1}, line number={2},
column number={3}.
CDIER0003E The XML type was not defined in
schema, name= {1}, line number= {2},
column number= {3}.
CDIER0004E The XML attribute was not defined in
schema, name={1}, line number={2},
column number={3}, source={4}.

Explanation: The value of each ID attribute must be
unique.
CDIER0014E If an element has content, the xsi:nil
attribute value cannot be set to true, an
error occurred because of an attempt to
assign xsi:nil='true' to an element that
contains data: value={0}, line number {1}
column number={2}, item name={3}.
CDIER0015E The data for this item does not conform
to the data type: step={5}, item name={1},
toType={0}, value={2}, line={3},
column={4}, source={6}.

CDIER0006E Unable to create the XML input stream,
cause={0}.

CDIER0016E Non-whitespace characters are invalid in
non-mixed case content in XML data:
item name={1}, line number={2}, column
number={3}.

CDIER0007E An error occurred while reading the
XML: cause={1}, systemId={2}, line
number={3}, column number={4},
step={5}, source={0}.

CDIER0017E An unexpected start or end element
name was encountered: line number={1},
column number={2}, actual name={3},
expected name={4}.

CDIER0008E The value for this XML attribute must
be a fixed value: attribute name={0},
fixed value={1}, value found={2}, item
name={3}, line number={4}, column
number={5}, source={6}.

CDIER0018E A missing start or end element name
was encountered: line number={1},
column number={2}, item name={3}.

CDIER0009E Missing required XML attribute:
attribute name={0}, item name={1}, line
number={2}, column number={3},
source={4}.
CDIER0010E One or more required XML elements are
missing from element with content type
'all' : name of parent element={0},
missing element={1}, line number={2},
column number={3}, source={4}.
CDIER0011E Missing XML data type: type name={0},
item name={1}, line number={2}, column
number={3}.
CDIER0012E The value specified for this data type is
invalid: item name={0}, line number={1},
column number={2}, name={3}, cause={1}.
CDIER0013E A duplicate value was specified for this
ID attribute: value={0}, item name={1},
line={2}, column={3}, step={4}, source={5}.

CDIER0019E A missing end element name was
encountered: item name={0}, line
number={1}, column number={2}.
CDIER0020E A missing start element name was
encountered: item name={0}, line
number={1}, column number={2}.
CDIER0021E An unexpected element was
encountered: item encountered={0}, line
number={1}, column number={2},
expected event names={3}, source={4}.
CDIER0022E An element that is not nillable was set
to xsi:nil='true': item name={0}, line
number={1}, column number={2},
source={3}.
CDIER0023E The number of array elements exceeds
the specified maximum: item name={0},
number of elements={3}, maximum
number allowed={4}, line number={1},
column number={2}, step={5}, source={6}.
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CDIER0024E • CDIER0604E
CDIER0024E The number of array elements is fewer
than the specified minimum: item
name={0}, number of elements={3},
minimum number allowed={4}, line
number={1}, column number={2},
step={5}, source={6}.

CDIER0402E Cannot read file={0}.
CDIER0403E Cannot write to file={0}.
CDIER0404E XSLT exception encountered, cause={0},
description={1}.

CDIER0025E Missing required item: item name={0}.
CDIER0405E XML parsing exception encountered={0}.
CDIER0026E The data for this item does not conform
to the item facet : source type={0}, item
name={1}, facet={2}, value={3}, line={4},
column={5}, step={6}, source={7}.
CDIER0027E An element that is not nillable was set
to xsi:nil='true': item name={0}.
CDIER0101E This output file cannot be created:
output file={0}, exception={1}.
CDIER0102E The data is illegal for the target item
type and cannot be converted: target
type={0}, item name={1}, value={2},
step={3}.
CDIER0103E The data does not conform to this facet:
type={0}, value={1}, facet={2}, step={3}.
CDIER0201E XQuery exception encountered={0}.
CDIER0303E Invalid data for target item type and
cannot be converted. step={3},
targetItem={4}, source type={0}, target
type={1}, value={2}.
CDIER0304E The source type cannot be converted to
the target type: step={2}, target item={3},
source type={0}, target type={1}.
CDIER0305E he facet type cannot be converted to the
target type: step={3}, target
item={4},target type={0}, facet={2},
value={1}.
CDIER0307E The data does not conform to the
column definition: step={3}, target
item={4}, target type={0}, attribute={2},
value={1}.
CDIER0401E An error occurred during XML parsing
because={0}.
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CDIER0406E SOAP exception encountered={0}.
CDIER0407E XQuery exception encountered={0}.
CDIER0408E Attempted to assign a null value to an
output link column that is not nullable
in the output step: column={0}.
CDIER0409E The input data in a comma separated
format file used in a test assembly does
not match the input schema, step={0},
column={1}.
CDIER0410E Error in step={1}, cause={0}.
CDIER0501E The Expression written in the Switch
step for filtering records failed={0}.
CDIER0502E The Expression written in the Switch
step for filtering records failed={0}.
CDIER0503E The Expression written in the Switch
step for filtering records failed={0},
result type={1}.
CDIER0504E Expression compilation failed, cause={0}.
CDIER0505E Invalid expression: mapping={0},
cause={1}.
CDIER0601E Cannot create directory={0}.
CDIER0602E Directory name is not a directory,
name={0}.
CDIER0603E Cannot write to directory={0}.
CDIER0604E Cannot delete file={0}.

CDIER0605E • CDIER0841E
CDIER0605E Cannot create file={0}.

CDIER0804E Link {0} in step {1} does not have a
column.

CDIER0606E Cannot write to file={0}, cause={1}.
CDIER0701E A timeout error occurred in step={0},
message={1}.
CDIER0702E A connection is refused in step={0},
message={1}.
CDIER0703E An action is not supported in step={0},
message={1}.
CDIER0801E Value of URL for XML input file is not
a string. value={0}.
CDIER0802E The assembly has {0} errors. Please edit
the Assembly to resolve.

CDIER0820E No scratch space available for partition
{0}.
CDIER0821E The following problem occurred during
disk-based support: {0}.
CDIER0831E The value of key field {0} has an invalid
value for the data type {2}.
CDIER0832E A key field without explicit length
specified has been truncated to 32,672
characters. Values that exceed this limit
will not be compared, key item
name={0}.
CDIER0841E Input type {1} is invalid for expression
{0}.

CDIER0803E step= {0}, targetItem={1}, targetType={2},
constant={3}.

Working with IBM Software Support to diagnose problems
Use these settings when you work with IBM Software Support to solve problems.
Choose Options in the Assembly Editor to display the following settings:
Assembly Context File
Click Download to save a copy of the assembly context file. This file,
which has the extension e2d, is useful for problem determination and
testing.
Logging
The file location of the log file and the log level.
Server Tracing
Enable tracing to record a trace log.
Flash Plug-in Diagnostics
This is informational.
Application Diagnostics
This is informational.
Note: If you change the default settings, they apply only to the current assembly.

Links to developer articles
Use the developer article links in this topic for more information about XML stage.
v Introduction - http://www.ibm.com/developerworks/data/library/techarticle/
dm-1103datastages/index.html
v Understanding the assembly - http://www.ibm.com/developerworks/data/
library/techarticle/dm-1103datastages2/index.html
v Understanding validation rules - http://www.ibm.com/developerworks/data/
library/techarticle/dm-1104datastages3/index.html
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Product accessibility
You can get information about the accessibility status of IBM products.
The IBM InfoSphere Information Server product modules and user interfaces are
not fully accessible. The installation program installs the following product
modules and components:
v IBM InfoSphere Business Glossary
v IBM InfoSphere Business Glossary Anywhere
v IBM InfoSphere DataStage
v IBM InfoSphere FastTrack
v
v
v
v

IBM
IBM
IBM
IBM

InfoSphere
InfoSphere
InfoSphere
InfoSphere

Information Analyzer
Information Services Director
Metadata Workbench
QualityStage

For information about the accessibility status of IBM products, see the IBM product
accessibility information at http://www.ibm.com/able/product_accessibility/
index.html.

Accessible documentation
Accessible documentation for InfoSphere Information Server products is provided
in an information center. The information center presents the documentation in
XHTML 1.0 format, which is viewable in most Web browsers. XHTML allows you
to set display preferences in your browser. It also allows you to use screen readers
and other assistive technologies to access the documentation.

IBM and accessibility
See the IBM Human Ability and Accessibility Center for more information about
the commitment that IBM has to accessibility.

© Copyright IBM Corp. 2010, 2011
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Accessing product documentation
Documentation is provided in a variety of locations and formats, including in help
that is opened directly from the product client interfaces, in a suite-wide
information center, and in PDF file books.
The information center is installed as a common service with IBM InfoSphere
Information Server. The information center contains help for most of the product
interfaces, as well as complete documentation for all the product modules in the
suite. You can open the information center from the installed product or from a
Web browser.

Accessing the information center
You can use the following methods to open the installed information center.
v Click the Help link in the upper right of the client interface.
Note: From IBM InfoSphere FastTrack and IBM InfoSphere Information Server
Manager, the main Help item opens a local help system. Choose Help > Open
Info Center to open the full suite information center.
v Press the F1 key. The F1 key typically opens the topic that describes the current
context of the client interface.
Note: The F1 key does not work in Web clients.
v Use a Web browser to access the installed information center even when you are
not logged in to the product. Enter the following address in a Web browser:
http://host_name:port_number/infocenter/topic/
com.ibm.swg.im.iis.productization.iisinfsv.home.doc/ic-homepage.html. The
host_name is the name of the services tier computer where the information
center is installed, and port_number is the port number for InfoSphere
Information Server. The default port number is 9080. For example, on a
Microsoft® Windows® Server computer named iisdocs2, the Web address is in
the following format: http://iisdocs2:9080/infocenter/topic/
com.ibm.swg.im.iis.productization.iisinfsv.nav.doc/dochome/
iisinfsrv_home.html.
A subset of the information center is also available on the IBM Web site and
periodically refreshed at http://publib.boulder.ibm.com/infocenter/iisinfsv/v8r7/
index.jsp.

Obtaining PDF and hardcopy documentation
v A subset of the PDF file books are available through the InfoSphere Information
Server software installer and the distribution media. The other PDF file books
are available online and can be accessed from this support document:
https://www.ibm.com/support/docview.wss?uid=swg27008803&wv=1.
v You can also order IBM publications in hardcopy format online or through your
local IBM representative. To order publications online, go to the IBM
Publications Center at http://www.ibm.com/e-business/linkweb/publications/
servlet/pbi.wss.
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Providing feedback about the documentation
You can send your comments about documentation in the following ways:
v Online reader comment form: www.ibm.com/software/data/rcf/
v E-mail: comments@us.ibm.com
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Reading command-line syntax
This documentation uses special characters to define the command-line syntax.
The following special characters define the command-line syntax:
[]

Identifies an optional argument. Arguments that are not enclosed in
brackets are required.

...

Indicates that you can specify multiple values for the previous argument.

|

Indicates mutually exclusive information. You can use the argument to the
left of the separator or the argument to the right of the separator. You
cannot use both arguments in a single use of the command.

{}

Delimits a set of mutually exclusive arguments when one of the arguments
is required. If the arguments are optional, they are enclosed in brackets ([
]).

Note:
v The maximum number of characters in an argument is 256.
v Enclose argument values that have embedded spaces with either single or
double quotation marks.
For example:
wsetsrc[-S server] [-l label] [-n name] source
The source argument is the only required argument for the wsetsrc command. The
brackets around the other arguments indicate that these arguments are optional.
wlsac [-l | -f format] [key... ] profile
In this example, the -l and -f format arguments are mutually exclusive and
optional. The profile argument is required. The key argument is optional. The
ellipsis (...) that follows the key argument indicates that you can specify multiple
key names.
wrb -import {rule_pack | rule_set}...
In this example, the rule_pack and rule_set arguments are mutually exclusive, but
one of the arguments must be specified. Also, the ellipsis marks (...) indicate that
you can specify multiple rule packs or rule sets.
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How to read syntax diagrams
The following rules apply to the syntax diagrams that are used in this information:
v Read the syntax diagrams from left to right, from top to bottom, following the
path of the line. The following conventions are used:
– The >>--- symbol indicates the beginning of a syntax diagram.
– The ---> symbol indicates that the syntax diagram is continued on the next
line.
– The >--- symbol indicates that a syntax diagram is continued from the
previous line.
– The --->< symbol indicates the end of a syntax diagram.
v Required items appear on the horizontal line (the main path).
 required_item



v Optional items appear below the main path.
 required_item


optional_item

If an optional item appears above the main path, that item has no effect on the
execution of the syntax element and is used only for readability.
optional_item
 required_item



v If you can choose from two or more items, they appear vertically, in a stack.
If you must choose one of the items, one item of the stack appears on the main
path.
 required_item

required_choice1
required_choice2



If choosing one of the items is optional, the entire stack appears below the main
path.
 required_item


optional_choice1
optional_choice2

If one of the items is the default, it appears above the main path, and the
remaining choices are shown below.
default_choice
 required_item


optional_choice1
optional_choice2

v An arrow returning to the left, above the main line, indicates an item that can be
repeated.
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 required_item  repeatable_item



If the repeat arrow contains a comma, you must separate repeated items with a
comma.
,
 required_item  repeatable_item



A repeat arrow above a stack indicates that you can repeat the items in the
stack.
v Sometimes a diagram must be split into fragments. The syntax fragment is
shown separately from the main syntax diagram, but the contents of the
fragment should be read as if they are on the main path of the diagram.
 required_item

fragment-name



Fragment-name:
required_item
optional_item

v Keywords, and their minimum abbreviations if applicable, appear in uppercase.
They must be spelled exactly as shown.
v Variables appear in all lowercase italic letters (for example, column-name). They
represent user-supplied names or values.
v Separate keywords and parameters by at least one space if no intervening
punctuation is shown in the diagram.
v Enter punctuation marks, parentheses, arithmetic operators, and other symbols,
exactly as shown in the diagram.
v Footnotes are shown by a number in parentheses, for example (1).
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Links to non-IBM Web sites
This information center may provide links or references to non-IBM Web sites and
resources.
IBM makes no representations, warranties, or other commitments whatsoever
about any non-IBM Web sites or third-party resources (including any Lenovo Web
site) that may be referenced, accessible from, or linked to any IBM site. A link to a
non-IBM Web site does not mean that IBM endorses the content or use of such
Web site or its owner. In addition, IBM is not a party to or responsible for any
transactions you may enter into with third parties, even if you learn of such parties
(or use a link to such parties) from an IBM site. Accordingly, you acknowledge and
agree that IBM is not responsible for the availability of such external sites or
resources, and is not responsible or liable for any content, services, products or
other materials on or available from those sites or resources.
When you access a non-IBM Web site, even one that may contain the IBM-logo,
please understand that it is independent from IBM, and that IBM does not control
the content on that Web site. It is up to you to take precautions to protect yourself
from viruses, worms, trojan horses, and other potentially destructive programs,
and to protect your information as you deem appropriate.
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Notices and trademarks
This information was developed for products and services offered in the U.S.A.

Notices
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.
IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.
For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan
The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.
This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
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sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:
IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003 U.S.A.
Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.
The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.
Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.
Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.
All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.
This information is for planning purposes only. The information herein is subject to
change before the products described become available.
This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.
COPYRIGHT LICENSE:
This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
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IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.
Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:
© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights
reserved.
If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and
service names might be trademarks of IBM or other companies. A current list of
IBM trademarks is available on the Web at www.ibm.com/legal/copytrade.shtml.
The following terms are trademarks or registered trademarks of other companies:
Adobe is a registered trademark of Adobe Systems Incorporated in the United
States, and/or other countries.
IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.
Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.
Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.
ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office
UNIX is a registered trademark of The Open Group in the United States and other
countries.
Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Notices and trademarks
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Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.
The United States Postal Service owns the following trademarks: CASS, CASS
Certified, DPV, LACSLink, ZIP, ZIP + 4, ZIP Code, Post Office, Postal Service, USPS
and United States Postal Service. IBM Corporation is a non-exclusive DPV and
LACSLink licensee of the United States Postal Service.
Other company, product or service names may be trademarks or service marks of
others.
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Contacting IBM
You can contact IBM for customer support, software services, product information,
and general information. You also can provide feedback to IBM about products
and documentation.
The following table lists resources for customer support, software services, training,
and product and solutions information.
Table 58. IBM resources
Resource

Description and location

IBM Support Portal

You can customize support information by
choosing the products and the topics that
interest you at www.ibm.com/support/
entry/portal/Software/
Information_Management/
InfoSphere_Information_Server

Software services

You can find information about software, IT,
and business consulting services, on the
solutions site at www.ibm.com/
businesssolutions/

My IBM

You can manage links to IBM Web sites and
information that meet your specific technical
support needs by creating an account on the
My IBM site at www.ibm.com/account/

Training and certification

You can learn about technical training and
education services designed for individuals,
companies, and public organizations to
acquire, maintain, and optimize their IT
skills at http://www.ibm.com/software/swtraining/

IBM representatives

You can contact an IBM representative to
learn about solutions at
www.ibm.com/connect/ibm/us/en/

Providing feedback
The following table describes how to provide feedback to IBM about products and
product documentation.
Table 59. Providing feedback to IBM
Type of feedback

Action

Product feedback

You can provide general product feedback
through the Consumability Survey at
www.ibm.com/software/data/info/
consumability-survey

© Copyright IBM Corp. 2010, 2011
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Table 59. Providing feedback to IBM (continued)
Type of feedback

Action

Documentation feedback

To comment on the information center, click
the Feedback link on the top right side of
any topic in the information center. You can
also send comments about PDF file books,
the information center, or any other
documentation in the following ways:
v Online reader comment form:
www.ibm.com/software/data/rcf/
v E-mail: comments@us.ibm.com
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